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Preface

Welcome to the Oracle Complex Maintenance, Repair, and Overhaul 
Implementation Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Complex Maintenance, Repair, and Overhaul.

If you have never used Oracle Complex Maintenance, Repair, and Overhaul, 
Oracle suggests you attend one or more of the Oracle Applications training 
classes available through Oracle University.

■ Oracle Self-Service Web Applications. 

To learn more about Oracle Self-Service Web Applications, read the Oracle 
Self-Service Web Applications Implementation Manual.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
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How To Use This Guide
The Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 
contains the information you need to understand and use Oracle Complex 
Maintenance, Repair, and Overhaul. This guide contains two chapters:

■ Chapter 1 provides an overview of Oracle Complex Maintenance, Repair, and 
Overhaul.

■ Chapter 2 describes the setup tasks that you need to perform in Oracle 
Applications for Oracle Complex Maintenance, Repair, and Overhaul.

■ Appendix A provides the necessary navigation paths.
x



Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Complex Maintenance, Repair, and Overhaul.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation- See the Online Documentation CD for current PDF 
documentation for your product with each release. This Documentation CD is 
also available on OracleMetaLink and is updated frequently. 

■ Release Content Document - See the Release Content Document for 
descriptions of new features available by release. The Release Content 
Document is available on OracleMetaLink. 

■ About document - Refer to the About document for information about your 
release, including feature updates, installation information, and new 
xi



documentation or documentation patches that you can download. The About 
document is available on OracleMetaLink. 

Related Guides
Oracle Complex Maintenance, Repair, and Overhaul shares business and setup 
information with other Oracle Applications products. Therefore, you may want to 
refer to other guides when you set up and use Oracle Complex Maintenance, 
Repair, and Overhaul.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Inventory User’s Guide
This guide describes how to define items and item information, perform receiving 
and inventory transactions, maintain cost control, plan items, perform cycle 
counting and physical inventories, and set up Oracle Inventory.

Oracle Bill of Materials User’s Guide
This guide describes how to create various bills of material to maximize efficiency, 
improve quality, and lower costs for the most sophisticated manufacturing and/or 
maintenance environments. By detailing integrated product structure and 
processes, flexible product and process definition, and configuration management, 
this guide enables you to manage product details within and across multiple sites.
xii



Oracle Work in Process User’s Guide
This guide describes how Oracle Work in Process provides a complete production 
management system. Specifically, this guide describes how discrete, repetitive, 
assemble-to-order, project, flow, and mixed manufacturing environments are 
supported.

Oracle Order Management User’s Guide
This guide describes how to enter sales orders and returns, copy exisiting sales 
orders, schedule orders, release orders, create price lists and discounts for orders, 
run processes, and create reports.

Oracle Enterprise Asset Management User’s Guide
This guide discusses maintenance work orders, how to manage them, and eAM’s 
preventive maintenance solution. eAM’s integration points and how to use them are 
described in detail.

Oracle Purchasing User’s Guide
This guide describes how to create and approve purchasing documents, including 
requisitions, different types of purchase orders, quotations, RFQs, and receipts. This 
guide also describes how to manage your supply base through agreements, 
sourcing rules and approved supplier lists. In addition, this guide explains how you 
can automatically create purchasing documents based on business rules through 
integration with Oracle Workflow technology, which automates many of the key 
procurement processes.

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning 
User’s Guide
This guide describes how to anticipate and manage both supply and demand for 
your items. Using a variety of tools and techniques, you can create forecasts, load 
these forecasts into master production schedules, and plan your end-items and their 
component requirements. You can also execute the plan, releasing and rescheduling 
planning suggestions for discrete jobs and repetitive schedules.

Oracle Projects User’s Guide
This guide provides instruction on how to set up and use Oracle Projects. If you 
install Oracle Projects, use this user guide to learn how to enter expense reports in 
Projects that you import into Payables to create invoices. You can also use this 
manual to see how to create Project information in Projects which you can then 
record for an invoice or invoice distribution.
xiii



Oracle Install Base Concepts and Procedures Guide
This guide provides an introduction to the concepts, and explains how to navigate 
the system, enter data, and query information in the Oracle Installed Base interface 
that forms part of Oracle Complex Maintenance, Repair, and Overhaul.

Oracle Warehouse Management User’s Guide
This manual provides information about warehouse resource management, 
warehouse configuration, and advanced pick methodologies for material handling 
for warehouses, manufacturing facilities, and distribution centers. This product is 
one of the components of Oracle Mobile Supply Chain Applications.

Oracle Install Base Implementation Guide
This guide provides information for setting up the contents of many of the lists of 
values (LOV) that you see in Oracle Install Base.

Oracle Quality User’s Guide
This guide describes how Oracle Quality can be used to meet your quality data 
collection and analysis needs. This guide also explains how Oracle Quality 
interfaces with other Oracle Manufacturing applications to provide a closed loop 
quality control system.

Oracle Contracts Core Concepts and Procedures Guide
This guide describes how Oracle Contract can be used to enable companies to 
author, execute, and manage virtually all business-to-business contracts required by 
complex global enterprises.

Oracle Customer Support Implementation Guide
This guide describes how to set up the list of values that you see in Oracle 
Customer Support. Oracle's service solution provides everyone in the organization - 
with a complete, real-time customer view that allows for immediate access to 
information on past interactions with the customer and also provides agents with 
knowledge of possible solutions to speed issue resolution. Additionally, the solution 
empowers customers to solve their own issues via a self-service portal with access 
to the same knowledge base that agents utilize for quick resolution.

Oracle Service Implementation Guide
This guide describes how to set up Oracle Service.
xiv



Oracle Self–Service Web Applications Implementation Guide
This manual contains detailed information about the overview and architecture and 
setup of Oracle Self–Service Web Applications. It also contains an overview of and 
procedures for using the Web Applications Dictionary.
xv



Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.
xvi



Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.
xvii



Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Complex Maintenance, Repair, and Overhaul implementation team, as well 
as for users responsible for the ongoing maintenance of Oracle Applications 
product data. This guide also provides information on creating custom reports on 
flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink

Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.
xviii



Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Complex Maintenance, Repair, and Overhaul and reach full productivity 
quickly. These courses are organized into functional learning paths, so you take 
only those courses appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Complex Maintenance, 
Repair, and Overhaul working for you. This team includes your technical 
representative, account manager, and Oracle’s large staff of consultants and support 
specialists with expertise in your business area, managing an Oracle server, and 
your hardware and software environment.
xix



Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Your Feedback
Thank you for using Oracle Complex Maintenance, Repair, and Overhaul and this 
user guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle Complex 
Maintenance, Repair, and Overhaul or this user guide. Mail your comments to the 
following address or call us directly at (650) 506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to mfgdoccomments_us@oracle.com.
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1

Oracle Complex Maintenance, Repair, and

Overhaul Overview

Oracle Complex Maintenance, Repair, and Overhaul (CMRO) enables maintenance, 
repair and overhaul organizations that manage complex configurable and regulated 
equipment systems, to define, plan and execute every aspect of their maintenance 
operations such as configuration management, engineering, maintenance planning, 
and execution. It provides maintenance organizations with the tools required to 
increase asset turnover, improve response times, and increase service levels. Oracle 
CMRO is a fully integrated component of Oracle’s 11i eBusiness suite.

This chapter includes the following topics:

■ Overview of Oracle Complex Maintenance, Repair, and Overhaul on page 1-1

■ Oracle CMRO Module Overview on page 1-3

Overview of Oracle Complex Maintenance, Repair, and Overhaul
Oracle Complex Maintenance, Repair, and Overhaul is designed to manage the 
entire business process of defining, planning and executing the maintenance of 
complex configurable and regulated equipment systems. Improved response times, 
increased service levels, and faster asset turnaround times are critical to maintaining 
successful long-term maintenance, repair, and overhaul (MRO) operations. Oracle 
CMRO offers features such as maintenance-based inventory management, 
reliability centered maintenance, a fully web-based architecture, and online access 
to repair documentation that enable maintenance organizations to maximize 
efficiency and save costs. By integrating every component of the maintenance, 
repair, and overhaul operation, Oracle CMRO provides complete real-time visibility 
across the entire operation.

Oracle CMRO enables organizations to do the following:
rview 1-1



Overview of Oracle Complex Maintenance, Repair, and Overhaul
■ Maintain complex configurations

■ Effectively plan enterprise-wide operations

■ Optimize maintenance execution

■ Centrally manage all engineering data

                    Maintaining Complex Configurations 
Organizations that build or maintain products with complex configurations need to 
track configuration history. Oracle CMRO enables you to establish master 
configurations. Requirements automatically flow to all units based on that master 
and the history is updated every time changes are made to the configuration. You 
can combine requirements with actual repair and usage results to provide 
unit-specific maintenance and configuration history. With this configuration control, 
you can easily track component history throughout the lifecycle. You can also 
classify units into smaller groups based on common attributes.

                    Effectively planning Enterprise-wide operations
Maintenance frequency and scope continually change based on usage, new 
regulatory requirements, and issues discovered during operation. Maintenance 
plans need to be updated periodically to ensure high asset reliability and safety. 
Oracle CMRO enables comprehensive fleet and unit-based maintenance planning 
and scheduling. You can establish Fleet maintenance programs to create 
maintenance requirements and to schedule maintenance activities. You can plan 
work across all locations to meet both short-term and long-term requirements. By 
long term planning, you can optimize capacity and resource utilization. 
Concurrently, you can make daily adjustments to respond to changes based on 
recent activities.

                    Optimizing Maintenance Execution 
Oracle CMRO enables you to streamline the execution process and simplify 
processes such as creating work orders, deploying resources, and updating 
maintenance history and configurations. Basic maintenance tasks associated with 
job creation and job completion are automated to increase worker productivity and 
to minimize aircraft downtime. You can capture results to ensure regulatory 
compliance and to guarantee traceability. Maintenance history is updated as and 
when work is completed. You can enter new service requests and work orders 
based on additional findings during scheduled maintenance activities. Oracle 
CMRO enables component shipping to and from third party maintenance 
1-2 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide



Oracle CMRO Module Overview
providers. You can also charge costs associated with maintenance activities 
throughout the repair cycle.

                    Centrally managing all Engineering data
Using Oracle CMRO, you can create, store, and manage data centrally. Oracle 
CMRO enables companies to leverage electronic storage and delivery of technical 
documentation for real-time access to accurate information and to ensure regulatory 
compliance. For example, you can capture quality information from all sources 
(suppliers, original equipment manufacturers, operators, third party maintenance 
providers) and store it in this single location to ensure traceability. Oracle CMRO 
provides for route management with reusable templates for individual operation 
instructions or a series of operations and an integrated document index. By 
automatically updating all related operations, these templates eliminate the need to 
perform system queries when route information is changed. Automating these 
processes eliminates costly manual labor, resulting in higher productivity and 
improved quality.

Oracle CMRO Module Overview
Oracle Complex Maintenance, Repair, and Overhaul enables organizations to 
streamline maintenance operations, meet the demands for transport and service, 
and improve profitability. Oracle CMRO comprises the following ten modules: 

                    Route Management
Using Route Management, you can maintain work cards in electronic form, so that 
they are easily accessible. You can use these work cards to provide technicians with 
task instructions and information on labor estimates, skill requirements, tools, parts, 
and materials required by the job. You can also remove redundant tasks and 
processes by storing each task card once in the database and then reusing it in 
multiple operations.

                    Document Index
Using Document Index, you can maintain references to paper documentation and 
include links that technicians can use to access electronic documents, either in the 
database or on the Web. You can keep all document references under version 
control to simplify compliance with regulations. You can also link document 
references to part types or individual serialized parts to eliminate searches, 
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maintain lists of suppliers, and automatically alert everyone on a distribution list 
when new documents or revisions arrive.

                    Fleet Maintenance Program
You can use CMRO’s Fleet Maintenance Program to create maintenance 
requirements for all planned and unplanned maintenance. You can associate work 
cards and maintenance documents with maintenance requirements and define 
effectivity by associating these maintenance requirements with a Master 
Configuration, Unit Configuration or a Product Classification. To forecast 
maintenance due dates, you can designate intervals and thresholds on maintenance 
requirements. The Affected Items Listing enables maintenance personnel to view all 
units affected by a maintenance requirement.

                   Master Configuration
Using Master Configuration, you can record the as designed configuration of the 
equipment that is maintained. This enables you to easily navigate through the 
hierarchy, specify which parts can be used in the assembly, and provide technicians 
with permissible part choices for each location. To enable technicians to easily 
access the information that they need, you can link documents to part positions and 
work cards. Master configurations can be used as templates for creating unit 
configurations.

                    Unit Configuration
You can use Unit Configuration to track the current as operated configuration of the 
equipment and to maintain the life cycle service history of the system and all the 
component parts, while considering the special conditions that affect service life 
measurements. To enable easy access to information, you can record the positions in 
the assembly where serialized parts are located and associate documents with them.

                    Product Classification
The Product Classification module enables you to classify units into various groups 
for maintenance activities and associate documentation and maintenance 
requirements to these product classifications. The maintenance plans are 
automatically updated when units move from one group into another.
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                    Unit Maintenance Plan
The Unit Maintenance Plan module enables you to maintain utilization forecasts, 
determine the remaining service time of units, and calculate due dates for 
maintenance requirements.

                    Visit Work Package
The Visit Work Package module enables you to create equipment-based 
maintenance visit definitions that connect equipment with a block of tasks, location 
and date. You can create and manage visit templates, and create visits from 
predefined templates. You can also manage maintenance requirements, calculate 
costs incurred on a visit using the visit task work breakdown structure, and define 
job hierarchy for all tasks in a visit.

                    Long Term Planning
The Long Term Planning module enables you to assess the maintenance workload 
capacity for all facilities and define a maintenance visit's resource requirements. You 
can schedule maintenance visits across the organization based on resource and 
facility availability, and compare resource capacities with resources required for the 
projected workload.

                    Production
The Production module enables you to view job assignments, component and 
material availability; record maintenance activities, job completion, material and 
component consumption; and update maintenance compliance details. To satisfy 
regulatory requirements, quality inspection results can be issued. You can initiate 
new service requests for unplanned maintenance discovered during planned 
maintenance visits.

The Production module enables you to track all time and materials associated with 
jobs throughout the repair cycle and interfaced to Oracle Costing, to provide 
maintenance organizations with a real view into service costs.

                    Production Planning
The Production Planning module offers maintenance organizations an extensive 
site-level planning tool. Production planners managing shop floor activities assign 
personnel and equipment to jobs, fine tune work schedules, manage procurement 
and create material requirements for unplanned maintenance. Using Production 
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planning, you can track components sent out for repair against the maintenance 
visit. Planners and shop floor managers consider working conditions when 
planning thereby ensuring a safe working environment.

                    Outside Processing
Using Outside Processing (OSP) you can ship serialized parts to Independent 
Service Organizations for service. Production planners assign jobs to third-party 
providers and group jobs that are marked for outside servicing onto an Outside 
Processing Work Order. The work order contains all the information required for 
executing the required service. When the OSP Work Order is finalized, purchase 
orders and shipping orders are created. After the work is completed, jobs are 
reassigned to internal personnel for quality checks and parts receiving.
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Setting Up

This chapter discusses setting up Oracle Complex Maintenance, Repair and 
Overhaul (CMRO). It includes the following topics:

■ Getting Started on page 2-1

■ Oracle CMRO Implementation Checklist on page 2-2

■ Setting Up Oracle CMRO on page 2-6

■ Setting Up Other Related Oracle Applications on page 2-6

■ CMRO Specific Setups on page 2-112

Getting Started
Before setting up CMRO, you must identify all your implementation users, and the 
access privileges they require. You can create additional implementation 
responsibilities if you want to restrict access.

You must use the System Administrator responsibility to create the required Oracle 
Applications user(s). Implementation users need access to one or more of the 
following responsibilities:

■ System Administrator

■ CMRO Super User

■ Foundation Administrator

■ Support Administrator

Use the Users window to define Oracle Applications users.Oracle Application user 
is uniquely identified by an application user name. 
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For detailed instructions on creating application users, refer to Oracle Applications 
System Administrator's Guide.

Oracle CMRO Implementation Checklist
The following tables comprise a checklist of all the steps you need to follow to 
implement Oracle Complex Maintenance, Repair & Overhaul. They include setup 
steps for data that is shared with other Oracle Applications, but is required by 
Oracle CMRO.

You must set up other related Oracle applications prior to setting up CMRO.

 

Table 2–1 Setting Up an Organization

Description Reference

Step 1 - Set Up an Operating Unit

Step 2 - Create an Organization

Step 3 - Set Up an Inventory Organization

Release 11i Multi-Org Today; An Oracle White 
Paper, December 2001

Oracle Human Resources User’s Guide

Table 2–2 Setting Up Oracle Inventory

Description Reference

Step 1 - Set Up Master Items

Step 2 - Set Up Subinventory

Oracle Inventory User’s Guide

Table 2–3 Setting Up Oracle Bills of Material (BOM)

Description Reference

Step 1 - Set Up Departments and Resources Oracle Bills of Material User’s Guide 

Table 2–4 Setting Up Oracle Warehouse Management

Description Reference

Step 1 - Associate Departments with        
Subinventories

Step 2 - Set Up Material Status

Step 3 - Associate Material Status with 
Subinventories

Step 4 - Set up Profile Options

Oracle Warehouse Management User’s Guide
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Table 2–5 Setting Up Oracle Purchasing

Description Reference

Step 1 - Set Up Buyers

Step 2 - Set Up Approvals

Step 3 - Set Up Purchasing Options

Step 4 - Set Up Receiving Options

Step 5 - Set Up Financial Options

Step 6 - Set Up Open Accounting Periods

Oracle Purchasing User’s Guide

Table 2–6 Setting Up Oracle Order Management

Description Reference

Step 1 - Set Up Security Processing 
Constraints

Step 2 - Set Up Customers

Oracle Order Management User’s Guide

Oracle Shipping Execution User’s Guide 

Table 2–7 Setting Up Oracle Project

Description Reference

Step 1 - Create Project Template

Step 2 - Assign Project Template Name to 
User Profile

Oracle Projects User’s Guide

Table 2–8 Setting Up Oracle Enterprise Asset Management

Description Reference

Step 1 - Set Up WIP Accounting Classes

Step 2 - Set Up EAM Parameters

Step 3 - Set Up Asset Category Code

Step 4 - Verify WIP_EAM_Activity_Priority 
Lookup

Oracle Enterprise Asset Management User’s 
Guide
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Table 2–9 Setting Up Oracle Material Requirement Planning (MRP)

Description Reference

Step 1 - Set Up Material Planning 
Parameters

Step 2 - Set Up Master Demand Schedule 
Names

Step 3 - Set Up MRP Names

Oracle Material Requirement Planning User’s 
Guide

Oracle Advanced Planning Implementation 
and User’s Guide, May 2003

Table 2–10 Setting Up Oracle Service

Description Reference

Step 1 - Define Service Request Status

Step 2 - Define Service Request Type

Step 3 - Define Service Request Severities

Step 4 - Set Up Profile Options

Oracle Customer Support Implementation 
Guide 

Table 2–11 Setting Up Oracle Contracts

Description Reference

Step 1 - Set Up Buyer

Step 2 - Set Up Supplier

Step 3 - Set Up Standard Articles

Step 4 - Set Up Categories and Sources

Step 5 - Set Up Contract Groups

Step 6 - Set Up Contract Events

Oracle Contracts Core Concepts and 
Procedures Guide 

Table 2–12 Setting Up Oracle Install Base

Description Reference

Step 1 - Set Up Install Parameters

Step 2 - Set Up Instance Statuses

Step 3 - Set Up Asset Locations

Oracle Install Base Implementation Guide
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Table 2–13 Setting Up Oracle Counters

Description Reference

Step 1 - Define Counter Groups Oracle Service Implementation Guide

Table 2–14 Setting Up Oracle Quality

Description Reference

Step 1 - Set Up Route and Operation 
Quality Plans

Step 2 - Set Up Deferral, MRB Disposition 
Quality, Non-Routine Job Inspection and 
Non-Routine Operation Inspection Plans

Step 3 - Create Counter Readings Quality 
Plan

Oracle Quality User's Guide

Table 2–15 Setting Up Oracle Content Manager

Description Reference

Step 1 - Setting up 
Interface Tables

-

Table 2–16 Oracle Complex Maintenance, Repair, and Overhaul Standard Setup

Description Reference

Step 1 - Set Up Profile Options -

Table 2–17 Oracle CMRO Approval Workflow Setup

Description Reference

Step 1 - Set Up Profile Options

Step 2 - Create Approval User(s) and Role

-
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Setting Up Oracle CMRO
Setting Up Oracle CMRO includes the following sections:

■ Setting Up Other Related Oracle Applications on page 2-6

■ CMRO Specific Setups on page 2-112

Setting Up Other Related Oracle Applications
Oracle CMRO is integrated with other applications that are part of the Oracle 
E-Business suite. This integration lends additional functionality to Oracle CMRO 
and enables it to fully support the maintenance, repair and overhaul needs of 
Operators, Third Party Maintainers, and Original Equipment Manufacturers. You 
must first set up an Organization and then install and implement the related Oracle 
applications or components.

This section covers the following topics:

■ Setting Up an Organization on page 2-7

■ Setting Up Oracle Inventory on page 2-34

■ Setting Up Oracle Bills of Material (BOM) on page 2-59

■ Setting Up Oracle Warehouse Management on page 2-63

■ Setting Up Oracle Purchasing on page 2-69

Table 2–18 Oracle CMRO Module Setup

Description Reference

Step 1 - Set Up Document Index

Step 2 - Set Up Route Management

Step 3 - Set Up Product Classification

Step 4 - Set Up Master Configuration

Step 5 - Set Up Unit Configuration

Step 6 - Set Up Fleet Maintenance Program

Step 7 - Set Up Unit Maintenance Plan

Step 8 - Set Up Visit Work Package

Step 9 - Set Up Long Term Planning

Step 10 - Set Up Production

-
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■ Setting Up Oracle Order Management on page 2-73

■ Setting Up Oracle Project on page 2-74

■ Setting Up Oracle Enterprise Asset Management on page 2-76

■ Setting Up Oracle Material Requirement Planning (MRP) on page 2-80

■ Setting Up Oracle Service on page 2-89

■ Setting Up Oracle Contracts on page 2-96

■ Setting Up Oracle Install Base on page 2-99

■ Setting Up Oracle Counters on page 2-102

■ Setting Up Oracle Quality on page 2-104

■ Setting Up Oracle Content Manager on page 2-111

Setting Up an Organization
In general, an organization can be a company, department, division, cost center, or 
virtually any other organizational unit within a business. Organization Setup 
includes the following steps:

■ Setting Up an Operating Unit on page 2-7

■ Creating an Organization on page 2-8

■ Setting Up an Inventory Organization on page 2-10

Setting Up an Operating Unit
An Operating Unit is the organization unit, through which you create, process, 
report on, and secure financial applications data.

To set up an Operating Unit, you must:
1. Develop an organization structure.

2. Define Set of Books. 

3. Define locations.

4. Define Business Groups (optional).

5. Associate responsibilities with Business Group (optional).

6. Define Organizations.
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7. Define Organization Relationships.

8. Define Responsibilities.

9. Set MO: Operating Unit profile option.

10. Convert to Multiorg Architecture (required only if current set up is not multiorg 
enabled).

11. Verify Order Management System parameters.

12. Set Profile Options specific to Operating Unit.

13. Define Inventory Organization security (optional).

14. Implement the application products.

Creating an Organization

To create an organization:
1. Select the Manufacturing and Distribution Manager responsibility. From the 

Navigator, select Inventory > Setup > Organizations > Organizations. The Find 
Organization window appears. 

2. Select New (A).

3. Enter an organization Name.

4. Select the following values from the Organization Classification list of values:

■ Business Group

■ HR Organization

■ GRE/Legal Entity

■ MRP Organization

■ Operating Unit

■ Project Expenditure

■ Project Manufacturing Organization

■ Project Task Owning Organization
2-8 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 



Setting Up an Organization
Figure 2–1 Organization

5. Select the Enable check box for all the above parameters.

6. Save your work.

Organization Classifications
Business Group: The purpose of the Business Group is to partition human resource 
information. The Business Group is the highest level in an organization structure 
hierarchy in the E-Business Suite. You can use the Business Group to model the 
consolidated enterprise or a major division of a company that is an employer.
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HR Organization: The HR Organization classification is applied to the 
organizations to which the user assigns employees.

Government Reporting Entities (GRE): The GRE in the Oracle Human Resources 
products is the same organization as the Legal Entity that appears in the Oracle 
Financial products. The GRE represents the real-world legal entity that pays 
employees, withholds their taxes, and provides reports on various matters 
concerning them to government agencies.

Setting Up an Inventory Organization
The Inventory Organization is an organization for which you track inventory 
transactions and balances.

To set up an Inventory Organization: 
1. From the Navigator, select Inventory > Setup > Organizations > Organizations. 

The Find Organization window appears.

2. Select New(A). The Organization window appears.

3. Enter an organization name in the Name field.

4. Within the Organization Classification block, select the following values from 
the Name list of values (LOV):

■ HR Organization

■ Inventory

■ MRP

■ Project Expenditure

■ Project Manufacturing Organization

■ Project Task Owning Organization

■ WIP Organization
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Figure 2–2 Organization Window

5. Select the Enable check box for each of the above mentioned classification. 

6. Save your work.

7. As indicated below, set up the parameters for each of the above mentioned 
Organization Classifications.

To set up HR Organization parameters:
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1. In the Organizations window, select HR Organization.Click the Others 
button.The Additional Organization Information window appears.

Figure 2–3 Additional Organization Information Window

2. Select Costing Information from the list. Enter a value in the Costing 
Information field. 

3. Save your work.
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4. Navigate to the Additional Organization Information window and choose 
Parent Organization from the list of values. Select Primary Reporting Hierarchy 
from the Hierarchy LOV.

5. From the Name LOV, select the organization that you have defined and enabled 
as a Business Group. 

6. Save your work.
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Figure 2–4 Parent Organization Window

To set up Inventory Organization parameters:
1. Select Inventory Organization in the Organizations window. Click the Others 

button. Choose Accounting Information from the list of values.

2. Click in the Accounting Information field. The Accounting Information 
descriptive flexfields window opens.
2-14 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 



Setting Up an Organization
3. Select the Set of Books, Legal entity and Operating Unit from their 
corresponding list of values. Click OK. 

4. Save your work.

Figure 2–5 Accounting Information Window
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5. Navigate to the Additional Organization Information window and select 
Inventory Information from the list. The Organization Parameters window 
opens.

6. Select the Inventory Parameters tab. Enter an Organization Code.

7. Select the Item Master Organization and Calendar from their corresponding list 
of values. 

8. Select the EAM Enabled check box. 

9. Save your work.
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Figure 2–6 Organization Parameters Window - Inventory Parameters 

 

10. Select the Revision, Lot, Serial parameters tab. Enter the following information:

Field Value

Lot Control Uniqueness None

Lot Control Generation At Organization Level
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Figure 2–7 Organization Parameters Window - Revision, Lot, Serial Parameters

Serial Control 
Uniqueness

Within Inventory Items

Serial Control Generation At Item Level

Field Value
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11. Save your work.

12. Select the Costing Tab. Select Average Costing from the Costing Method list of 
values.

13. Select the Enable Project Cost Collection check box.

14. Enter the required information in the Valuable Accounts block. 

15. Save your work.
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Figure 2–8 Organization Parameters Window - Costing Parameters

16. Click the ATP, Pick, Item-Sourcing parameters tab. Select an ATP Defaults Rule 
from the Rule LOV. 

17. Save your work.
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Figure 2–9 Organization Parameters Window - ATP, Pick, Item-Sourcing Parameters 

To set up MRP Organization parameters:
1. In the Organization window, select MRP Organization. Click the Others button.

2. The Planning Parameters window opens. Select the Net WIP and Net 
Reservation check box. 

3. Save your work.
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Figure 2–10 Planning Parameters Window

To set up Work in Process (WIP) Organization parameters:
1. Select WIP Organization in the Organization window. Click the Others button.

2. Click the Backflush Defaults tab. Select Supply subinventory from the LOV. 
Enter a Supply Locator (if required).
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Figure 2–11 Work In Process Parameters Window - Backflush Defaults Tab

 

3. Select the Move Transaction tab. Check the Allow Creation of New Operations 
and the Allow Moves Over No Move Shop Floor Statuses check boxes.
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Figure 2–12 Work In Process Parameters Window - Move Transaction Tab

4. Select the Intra-operation tab. Enable the Queue Check Box. Disable other check 
boxes. 

5. Save your work.
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Figure 2–13 Work In Process Parameters Window - Intraoperation Tab

6. From the Navigator, select WIP > Setup > WIP Accounting Class.

7. Enter a Class and Description.

8. Select Standard Discrete from the Type drop-down list. Enter Accounts 
information. 

9. Save your work.
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Figure 2–14 WIP Accounting Classes Window

 

10. Similarly, create Expense Non-Standard, Maintenance, and Asset Non-Standard 
Accounting Classes. For more information about setting up Accounting classes, 
see the Oracle Work in Process User’s Guide.

11. Save your work. 

12. From the Navigator, select Inventory >Setup > Organizations > 
Organizations.Query for your Organization.
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13. Select WIP Organization within the Organization Classifications block. Click the 
Others button.The Work in Process parameters window appears. 

14. Select the Discrete tab. Choose a default Discrete Class from the Default 
Discrete Class list of values.

15. Save your work.

Figure 2–15 Work in Process Parameters Window - Discrete Tab
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To set up Project Manufacturing parameters:
1. In the Organizations window, select Project Manufacturing Organization. Click 

the Others button. The Project Manufacturing Parameters window opens. 

2. Select the General tab. Check the Enable Project Reference check box.

3. Select Task from the Project Control Level drop-down list.

Figure 2–16 Project Manufacturing Parameters Window - General Tab
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4. Click the Invoice Transfer tab. Check the IPV check box to enable IPV.

5. Select Material from the Expenditure Type LOV.

6. Save your work.

Figure 2–17 Project Manufacturing Parameters Window - Invoice Transfer Tab
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To set up Project Task Owning Organization parameters:
1. In the Organizations window, select Project Task Owning Organization. Click 

the Others button. The Additional Organization Information window opens.

2. Click in the Project Type Class Information field. In the Project Type Class 
Information sub-window that opens, select Yes for all the following parameters:

■ Allow Entry of Indirect Projects 

■ Allow Entry of Capital Projects 

■ Allow Entry of Contract Projects 

3. Click Ok. Save your work.
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Figure 2–18 Project Type Class Information Window

To set up Project Expenditure/Event Organization parameters:
1. In the Organizations window, select Project Expenditure/Event Organization. 

Click the Others button. 

2. Click in the Exp Org Defaults field. The Exp Org Defaults sub-window appears.

3. Enter or select an Operating Unit (the same as the item master Organization). 
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4. Save your work.

Figure 2–19 Exp Org Defaults Window

Additional Setup 
1. From the Navigator, select Inventory > Accounting Close Cycle > Inventory 

Accounting Periods.
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2. Select an Inventory Accounting Period and change status to Open.

3. Save your work.

Figure 2–20 Inventory Accounting Periods Window

 See Also:
Release 11i Multi-Org Today; An Oracle White Paper, December 2001 
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In Oracle CMRO, you use instances of Oracle Inventory when defining the 
allowable parts in a master configuration, and when describing the components in a 
unit configuration. Oracle CMRO invokes Oracle Inventory methods to populate 
the database with information on allowable components in a configuration, and the 
components actually available to create a unit configuration. The Production 
module uses predefined inventory items as reference when invoking the inventory 
methods that issue and return parts, or when defining the material requirements for 
an organization job. The route management module uses the predefined inventory 
items as material and tool requirements used to perform a route or an operation.

Setting up Oracle Inventory includes the following steps:

■ Creating Component Items

■ Creating Service Items

■ Setting Up Subinventory

For every Inventory Organization, you must define Items and set up at least one 
subinventory. Cost group and Locator should have been setup prior to setting up 
subinventory.

To create Component Items
1. Select the Manufacturing and Distribution Manager responsibility. From the 

Navigator, select Inventory > Items > Master Items.

2. Enter a name in the Item field.

3. Enter a description in the Description field.

4. Click the Main tab. Select Active from the Item Status drop-down menu.

Note: All items must be set up at the Master Inventory 
Organization Level and then assigned to specific Inventory 
Organizations. Oracle recommends that you define an Item 
Template for each type of item that will be used in your 
organization.
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Figure 2–21 Master Item Window - Main Tab

5. Click the Inventory tab. Select the following check boxes:

■ Inventory Item

■ Stockable

■ Reservable
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■ Transactable

6. For Lot and Lot Expiration, select No control from the Control drop-down 
menu.

7. Select Serial Control: At receipt (if the items are serial number trackable; 
otherwise set it to non-serialized) from the Serial Generation drop-down menu.

8. Select No Control from the Locator Control drop-down menu.
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Figure 2–22 Master Item Window - Inventory Tab

9. Click the Bills of Material tab. Select the BOM Allowed check box.
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Figure 2–23 Master Item Window - Bills of Material Tab

10. Click the Asset Management tab. Select Rebuildable from the Asset Item Type 
drop- down menu.
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Figure 2–24 Master Item Window - Asset Management Tab 

11. Click the Costing tab. Select the following check boxes:

Note: You can select a value in the Asset Item Type field only if 
Oracle Enterprise Asset Management(eAM) set up is complete. Set 
up at least one item with Asset Group of Rebuildable in eAM. 
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■ Costing Enabled

■ Inventory Asset Value

■ Include in Rollup

12. Enter value for Cost of Goods Sold Account.

Figure 2–25 Master Item Window - Costing Tab
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13. Click the Purchasing tab. Select the following check boxes:

■ Purchased

■ Purchasable

■ Allow Description Update

14. Under Invoice Matching, set Receipt Required to No.
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Figure 2–26 Master Item Window - Purchasing Tab

15. Click the Physical Attributes tab.

Note: When you enter values for Weight, Volume, and 
Dimensions, you must select the Container check box to ensure that 
the shipment flow works properly.
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16.  Click the General Planning tab. Select Min-Max from the Inventory Planning 
Method drop-down menu.

Figure 2–27 Master Item Window - General Planning Tab

17. Click the MSP/MRP Planning tab. Select MRP Planning from the Planning 
Method drop-down menu.
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18. Select Hard Pegging from the Pegging drop-down menu.

Figure 2–28 Master Item WIndow - MSP/MRP Planning Tab

19. Click the Order Management tab. Select the following check boxes:

■ Customer Ordered

■ Internal Ordered
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■ Customer Orders Enabled

■ Internal Orders Enabled

■ Shippable

■ OE Transactable

■ Returnable 
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Figure 2–29 Master Item Window - Order Management Tab 

20. Click the Work in Process tab. Select the Build in WIP check box.

21. Select Supply Type of Push from the Supply Type drop-down menu.
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Figure 2–30 Master Item Window - Work in Process Tab

22. Click the Invoicing tab. Select the Invoiceable Item and Invoice Enabled check 
boxes.
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Figure 2–31 Master Item Window - Invoicing Tab

23. Click the Service tab. Select the Serviceable Product and Install Base Tracking 
check boxes.

24. Save your work.

To set up Service Items
1. Set up Service Items with attributes as described below.
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Attribute Value

Item Status

Inventory Item

Stockable

Reservable

Purchased

Purchasable

Description Update

Receipt Required

OSP 

Active

Disabled

Disabled

Disabled

Enabled

Enabled

Enabled

Yes

Disabled
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Figure 2–32 Master Item - Purchasing Tab

2. Save your work.

To set up Subinventory
1. From the Navigator, select Inventory > Setup > Organization > Subinventories. 

The Subinventories window appears.

2. Define the following subinventories:
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Stores
3. Type Stores in the Name field.

4. Select Active from the Status list of values.

5. Select the following check boxes:

■ Quantity Tracked

■ Asset Subinventory

■ Include in ATP

■ Allow Reservation

■ Nettable

Note: Cost group and locators must be set up before defining 
subinventories.
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Figure 2–33 Subinventories Window (Stores Subinventory)

6. Select the Accounts tab and enter appropriate accounting values.

7. Save your work.
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Figure 2–34 Subinventories Window - Accounts Tab

MRB
8. Click the New icon to create a new subinventory. Type MRB in the Name field.

9. Select Active from the Status list of values.
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10. Select the following check boxes:

■ Quantity Tracked

■ Asset Subinventory

■ Allow Reservation

Note: The status must be set to MRB Review. You must install 
Oracle Warehouse Management (WMS) to use this status. You can 
set the status to Active initially, install Warehouse Management, 
create additional Transaction Types in WMS and then change 
subinventory status to 'MRB Review'.
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Figure 2–35 Subinventories Window (MRB Subinventory)

11. Select the Accounts tab and enter appropriate accounting values. 

12. Save your work.
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Consumable
13. Click the New icon to create a new subinventory. Type Consumable in the 

Name field.

14. Select Active from the Status list of values.

15. Select the Quantity Tracked check box. Disable all other attributes.

Figure 2–36 Subinventories Window (Consumable Subinventory)
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16. Select the Accounts tab and enter appropriate accounting values.

17. Save your work.

Scrap

18. Define a new subinventory by clicking the New icon. Type Scrap in the Name 
field.

19. Select Unserviceable from the Status list of values. 

20. Select the Quantity Tracked check box. Disable all other attributes.
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Figure 2–37 Subinventories Window (Scrap Subinventory) 

21. Select the Accounts tab and enter appropriate accounting values.

22. Save your work.

See Also:
Oracle Inventory User’s Guide
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Setting Up Oracle Bills of Material (BOM)
Oracle CMRO uses the resources and departments that are set up in Oracle Bills of 
Material as the basis for the production job resource requirements.

Before setting up Oracle Bills of Material, you must ensure that:

■ Calendars and Exception templates are set up

■ Employees have been set up

Setting up Oracle Bills of Material includes setting up departments and resources.

To set up Departments and Resources:
1. Select the Manufacturing and Distribution Manager responsibility. From the 

Navigator, select Bills of Material > Setup > Department Classes

2. Set up Department Classes. For Outside Processing purposes you must set up at 
least one Department Class called Vendor.
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Figure 2–38 Department Classes Window

3. To set up a department, navigate to Bills of Material > Routings > Department. 
The Departments window appears.

4. Set up at least one Department that will be associated with the department class 
Vendor (case sensitive). It is recommended that you set up a Department that 
the users can easily identify as an outside department, for example, Outside 
Service (OSV).
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5. Associate all Departments with a location.

Figure 2–39 Departments Window

 

6. Set up Resources and associate with Employees. To set up resources navigate to 
Routings > Resources.

7. Define a resource of type Machine.
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Figure 2–40 Resources Window

8. Set up Standard Operations.

Note:  In the item master you must check 'Equipment' flag 
(Physical attributes) to see valid values.
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9. Save your work

See Also:
Oracle Bills of Material User’s Guide

Setting Up Oracle Warehouse Management
Oracle Warehouse Management provides maintenance organizations, the 
functionality to control their inventory by status/condition and associate 
subinventories with a department. Before setting up Oracle Warehouse 
Management, you must ensure that:

■ Oracle Inventory setup is complete

■ Supply subinventories are setup

■ Departments have been set up in Oracle BOM

Setting up Oracle Warehouse Management includes:

■ Associating departments with subinventories

■ Defining Material status

■ Associating material status with subinventories

■ Setting up Profile Options 

To associate departments with subinventories:
1. Change responsibility to Warehouse Management Super User. From the 

Navigator, select Setup > Warehouse Configuration > Resources > Associate 
Departments & Subinventories. The Department Subinventories window 
appears.

2. Select a department from the Department list of values and associate it with a 
Subinventory.

3. Save your work.

Note: You must set up Departments and Resources at the 
operating unit, as well as at the Inventory Organization level. 
Routes are set up at the operating unit level. Visits (Visit Work 
Package - CMRO) are set at the Inventory Organization level.
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Figure 2–41 Department Subinventories Window

To set up Material Status:
1. Navigate to Setup > Transaction Setup > Inventory Transactions > Material 

Status. The Material Status Definition window appears.

2. Set up the following statuses:

■ MRB
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■ Unserviceable

■ Serviceable

Figure 2–42 Material Status Definition Window

3. Save your work.
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To associate Material Status with Subinventories:
1. Navigate to Setup > Warehouse Configuration > Warehouse > Subinventories. 

The Subinventories Summary window appears.

2. Select a subinventory and associate a Material Status with it.

Figure 2–43 Subinventories Summary Window
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To set up Profile Options
1. Change responsibility to Application Developer. Navigate to Other > Profile. 

The Personal Profile Values window appears.

2. Set up the Profile options as indicated in the table below.
 

Profile Name User Value

AHL: Material Status - Serviceable

AHL: Material Status - Unserviceable

AHL: MRB Material Status - MRB

Serviceable

Un-Serviceable

MRB
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Figure 2–44 Personal Profile Values Window

3. Save your work.

See Also:
Oracle Warehouse Management User’s Guide
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Setting Up Oracle Purchasing
Before setting up Oracle Purchasing, you must ensure that:

■ Oracle Inventory setup is complete

■ Supply sub-inventories have been set up

■ Oracle Human Resources setup is complete

To set up Oracle Purchasing:
1. Change responsibility to Manufacturing and Distribution Manager. From the 

Navigator, select Purchasing.

2. Set up the following in Oracle Purchasing:

■ Buyers

■ Approvals

■ Purchasing Options

■ Receiving Options

■ Financial Options

■ Open Accounting Periods
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Figure 2–45 Approval Groups Window
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Figure 2–46 Buyers Window
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Figure 2–47 Open Accounting Periods Window

3. Save your work.

See Also:
Oracle Purchasing User’s Guide
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Setting Up Oracle Order Management
Before setting up Oracle Order Management (OM), you must ensure that:

■ Oracle Inventory setup is complete

■ Supply sub-inventories have been set up

■ Oracle Purchasing setup is complete

Setting up Oracle Order management includes:

■ Setting up Processing Constraints

■ Creating Customers

To set up Processing Constraints:
1. From the Manufacturing and Distribution Manager responsibility, navigate to 

Order Management > Set Up > Rules > Security > Processing Constraints. The 
Processing Constraints window appears.

2. Query for the Order Sales Credit entity using the Find icon.

3. In the Constraints field, disable Create, Update, Delete, and Cancel Operations.

4. Click the Applicable To tab. Select the Authorized Responsibilities Radio Button 
and provide a list of Responsibilities that can perform the above listed actions. 

5. Save your work.

6. Query for the Order Line entity.

7. Disable Create, Update, Delete, and Cancel operations for the same.

8. Click the Applicable To tab. Select the Authorized Responsibilities Radio Button 
and provide a list of Responsibilities that can perform the above listed actions. 
Save your work.

To define Customers: 
1. Navigate to Customers > Standard. The Find/Enter Customers window opens.

2. Define your customers.

Note: Setting up Processing Constraints ensures that Order 
Management users are not able to update Sales Orders created 
within CMRO.
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See Also:
Oracle Order Management User’s Guide

Setting Up Oracle Project
Oracle's CMRO application uses Projects as part of its maintenance planning and 
production flows. A project is created for each visit work package and project tasks 
are created for each visit work package. The project tasks are used in the 
maintenance planning flow to allow the required materials to be pegged to the 
corresponding visit tasks through Oracle's MRP application. A visit's corresponding 
project is used in the maintenance execution flow to collect costs associated to 
resource and material transactions performed in CMRO's Production module. 
Project Manufacturing's standard billing functionality can be used to generate the 
required reports for the corresponding visit work packages.

Setting up Oracle Projects includes the following steps:

■ Creating a Project Template

■ Assigning the Project Template name to an user profile

To create a Project Template:
1. Change responsibility to Project Super User. From the Navigator, select Setup > 

Projects > Project Templates.

2. Click on New. Enter the required information.

3. Select the Template check box to classify the project as template.

4. Ensure that all Project Class Categories that are marked Required are included, 
else you cannot approve Project Templates. Save the Project Template.

Note: For outside order processing, you must set up customers in 
Order Management identical to the suppliers that you created in 
Oracle Purchasing. You must do this step for only those suppliers to 
whom you will be shipping out the parts for service. Oracle 
recommends that you create customer names to be exactly the same 
as your supplier name.
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5. The Project Status changes to Submitted. For more information about the 
creation of project templates and the manner in which you use them to create 
projects and submit for approval, refer to the Oracle Projects User’s Guide.

To assign the Project Template name to an user profile
1. Change responsibility to System Administrator. From the Navigator, select 

Profile > System. The Find System profile Values window appears.

2. Find System Profile Value - AHL: Default Project Template ID. 

3. Select the Project Template that you created from the Site LOV.

4. Save your work.

For for information on System profile options and the procedures for setting them 
up, refer to the Oracle Applications System Administrator's Guide.

Verifying/Updating the Project Created in the Visit Work Package(CMRO) 
Each time the maintenance planner creates a project in Visit Work Package(CMRO), 
the project's parameters must be manually defined.

To verify/update the project created in the CMRO Visit Work Package:
1. Change responsibility to Manufacturing and Distribution Manager. From the 

Navigator, select Project > Project Definitions > Project Parameters. The Project 
Parameters window appears.

Note: This template should be created for the applicable inventory 
master organization. All projects created for maintenance visits use 
this project template.

Note: You can change most of your user profile options; values 
you enter in the User Value field overriding the values preset by the 
System Administrator. A few profile options cannot be changed, 
but are displayed for informational purposes only. To change the 
User Profile options, from the Application Developer 
Responsibility, navigate to Other > Profile. Enter the required 
values in the Personal Profile Values window. 
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2. Enter the Visit Number in the Project Number field to search for the project 
created in Visit Work Package.

3. Verify the Organization name.It should be the same as the Visit Work Package 
organization.

4. Optionally, change the Cost Group.

5. Optionally, change the Default WIP class.

6. Select the Invoice Transfer tab.Optionally, change the IPV. 

7. Make other changes if required.

See Also:
Projects User Guide Release 11i

Setting Up Oracle Enterprise Asset Management
Oracle CMRO uses the same work order system as Oracle Enterprise Asset 
Management (eAM). It also uses the Oracle eAM functionality to complete 
operations. Oracle CMRO benefits from Oracle eAM’s enhanced integration with 
Oracle Costing.

Before setting up Oracle eAM, you must ensure that:

■ Oracle Inventory setup is complete

■ Oracle WIP setup is complete

■ Oracle BOM setup is complete

■ Oracle Purchasing setup is complete

To set up Oracle Enterprise Asset Management:
1. Change responsibility to Enterprise Asset Management. 

2. Navigate to Setup > WIP > WIP Accounting Classes. Set up the following WIP 
Accounting Classes:

■ Standard

■ Expense

■ Maintenance

■ Asset Non-Standard
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Figure 2–48 WIP Accounting Classes Window

3. Set up the eAM parameters.
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Figure 2–49 Enterprise Asset Management Parameters Window

4. Navigate to Setup > Category > Category Codes. Set up the Asset Category 
Code for structure Asset Management. 

5. To establish the Asset Category as the default category, navigate to Set up > 
Category > Category Sets. The Category Sets window appears. 
2-78 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 



Setting Up Oracle Enterprise Asset Management
6. Query for Enterprise Asset Management in the Name field. Select the Category 
code that you created from the Default Category list of values. 

7. Save your work.

8. Navigate to Setup > Lookup. The Oracle Manufacturing Lookups window 
appears. Query for WIP_EAM_ACTIVITY_PRIORITY lookup in the Type field. 
Verify that the following values are setup:

Code Meaning

1 High

2 Medium

3 Low
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Figure 2–50 Oracle Manufacturing Lookups Window

See Also: 
Oracle Enterprise Asset Management User Guide 

Setting Up Oracle Material Requirement Planning (MRP)
Before you set up Oracle MRP, you must ensure that:
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■ Oracle Inventory setup is complete

■ Supply sub-inventories are set up

■ Organization Items are set up with MRP Planning enabled

■ Oracle Purchasing setup is complete

■ Oracle WIP setup is complete

■ Oracle eAM setup is complete

■ Oracle Project Manufacturing setup is complete

■ Profile option INV: Capable to Promise is set to ATP Based on Collected Data

■ The ATP Data Collection concurrent program is run

Setting up Oracle MRP includes:

■ Setting up MRP parameters

■ Setting up Master Demand Schedule (MDS) Names 

■ Setting up MRP Names

To set up MRP parameters:
1. Change responsibility to Manufacturing and Distribution Manager. From the 

Navigator, select Material Planning > Setup > Parameters. The Planning 
Parameters window opens.

2. Select the Enable Net WIP and Net Reservations check boxes.

3. Select Order start date from the Material Scheduling Method drop-down menu.

4. Select All planned items from the Planned Items drop-down menu.

5. Save your work.

Note: The ATP Data Collection concurrent program can be run 
from the Oracle Order Management responsibility(Order 
Management > Scheduling > ATP Data Collection). For more 
information on ATP Data Collection, refer to the Oracle Global Order 
Promising Implementation and User's Guide.   
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Figure 2–51 Planning Parameters Window

6. Navigate to Material Planning > Setup > Planning Manager. Select the Active 
check box. If this check box is not selected, MRP will not pick up MDS entries 
from Visit Work Package.

7. Save your work.
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Figure 2–52 Planning Manager Window

To set up MDS Names:
1. Navigate to Material Planning > MDS > Names. The Master Demand Schedules 

window appear.
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2. Set up the MDS names. It is recommended that you define Names such that the 
user can easily identify with which subinventory the Master Demand Schedule 
is going to be associated. 

3. Select the Relieve check box. 

4. Save your work.

Figure 2–53 Master Demand Schedules Window
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To set up MRP Names:
1. Navigate to Material Planning > MRP > Names. The MRP Names window 

appears.

2. Set up MRP names. Oracle recommends that you define MRP names in such a 
way that the planner can identify the specific subinventory it will be associated 
with.

3. Select the Feedback and Production check boxes.
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Figure 2–54 MRP Names Window

4. Click the Options button. The Plan Options window appears. Select the MDS 
name from the Schedule list of values. It is recommended that you select the 
MDS with the same subinventory name as the subinventory you intend to 
associate with this plan.

5. Select the following check boxes:

■ Append Planned Orders
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■ Net WIP

■ Net Reservations 

■ Pegging 

6. For Reservation Level and Hard Pegging Level, select Project-Task from their 
corresponding drop-down menus.

7. Select Order Start Date from the drop-down menu for Material Scheduling 
Method.

8. Select All planned items from the Planned Items drop-down menu.
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Figure 2–55 Plan Options Window

9. Click the Subinventory Netting button. Select a single subinventory that will be 
associated with this plan. 

10. Save your work.
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See Also:
Oracle Materials Requirement Planning User’s Guide

Setting Up Oracle Service
Oracle Service provides Oracle CMRO with the functionality to create and update 
service requirements in a maintenance organization. The association of a service 
request to a visit task and production job allows the maintenance organization to 
track the service difficulty (non-routine) to the associated progress or resolution 
performed by the maintenance personnel.

Setting up Oracle Service includes:

■ Verifying/ Defining Service Request Type, Status, and Severity

■ Setting up the Profile Options

To verify/define Service Request Type, Status, and Severities:
1. Change responsibility to Customer Support. From the Navigator choose Setup 

> Service Request > Request Status. The Service Request Statuses window 
appears.

2. You can define the following statuses:

■ New

■ Open

■ Working

■ Assigned

■ Closed

Note: The MRP plan must be associated with a single 
subinventory for MRP/Production Planning to work properly. If 
you associate multiple sub-inventories with the plan then the 
Planner/Materials Manager will have to manually check material 
requirements against availability. It may entail moving materials 
between sub-inventories in order to meet the job's material 
requirements.
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Figure 2–56 Service Request Statuses Window

3. Navigate to Setup > Service Request > Request Types. The Service Request 
Types window appears. 
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4. You can define the following Request Types:

■ Pilot Log

■ Cabin Log

■ Mechanic Log

■ Inspection Log

■ Technical Problem

Note: You define service Request Types to categorize your service 
requests. For each service request type, you can set up related 
service request statuses that correspond with each service request 
type
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Figure 2–57 Service Request Types Window

5. Navigate to Setup > Service Request > Request Severities. The Service Request 
Severities window appears. 

6. Verify that the following Request Severities are defined: 

■ High

■ Medium
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■ Low

Figure 2–58 Service Request Severities Window

Select values in the Type, Status, and Severity fields, if they are different than the 
default values. Default values in these fields are governed by the profiles setup. For 
more information on profiles, see Setting Up Oracle Support Profiles in the Oracle 
Support Implementation Guide.
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You can override these defaults if necessary by changing the appropriate profile 
options. For more information, see Setting Up Support Related Profile Options in 
the Oracle Support Implementation Guide.

To set up the Profile Options:
1. Change responsibility to System Administrator. Navigate to Profile > System. 

The Find System Profile Values window appears.

2. Find System profile value - AHL: Default SR Customer Name. Select the default 
Customer Name from the Site LOV. 

3. Save your work.

4. Find System profile value - AHL: Default SR Severity. Select the default Severity 
Value from the Site LOV. 

5. Find System profile value - AHL: Default SR Status. Select a default Status 
Value.

6. Find System profile value - AHL: Default SR Type. Select the default SR Type. 

7. Save your work.
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Figure 2–59 System Profile Values Window

Note: You can change most of your user profile options; values 
you enter in the User Value field override values preset by the 
System Administrator. A few profile options are set for 
informational purposes only, and cannot be changed.
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See Also:
Oracle Customer Support Implementation Guide

Setting Up Oracle Contracts
CMRO’s Outside Processing module uses the Oracle Contracts’ functionality 
supporting Loan and Borrow Transaction. 

Before you set up Oracle Contracts, you must ensure that:

■ Oracle Inventory setup is complete

■ Oracle Receivables setup is complete

■ Oracle Order Management setup is complete

■ Oracle Purchasing setup is complete

Setting up Oracle Contracts includes:

■ Setting up Buyers

■ Setting up Suppliers

■ Other Setups

To set up Buyers:
1. From the Navigator, select Contract Manager > Setup > Others > Buyer > Buyer. 

The Find Buyer window appears. Click the New Buyer button.

2. Select a Buyer Name from the list of values.

3. Enter other required data.
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Figure 2–60 Buyers Window

Note: The buyers setup in Oracle Contract will be displayed in the 
CMRO Select Buyer Name list for the user to select as the OSP 
Buyer.
Setting Up 2-97



Setting Up Oracle Contracts
To set up Suppliers
1. Navigate to Contract Manager > Setup > Others > Supplier > Entry. The 

Suppliers window appears.

2. Enter required information. 

Figure 2–61 Suppliers Window
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Other setups:
1. Navigate to Contract Manager > Setup > Contract. Verify the contract setup.

2. Set up Standard Articles and Categories and Sources.

3. Optionally, set up Customers.

4. Set up Contract Groups and Contract Events.

See Also:
Oracle Contracts Core Concepts and Procedure Guide

Setting Up Oracle Install Base
After you define the master configuration, a framework exists that describes the 
general characteristics of the system, including the engineering rules for assembly. 
The user can then create a unit configuration. Oracle Complex uses the Installed 
Base’ methods to populate the database with transactions representing the as 
operated configuration of the system.

Before you set up Oracle Install Base, ensure that:

■ Oracle Inventory setup is complete

■ Oracle Counters setup is complete

■ Supplier and supplier sites are set up (Purchasing)

■ Customer and customer sites are set up (Receivables)

To set up Oracle Install Base:
1. Change responsibility to Oracle Installed BaseAdmin. Navigate to Setup > 

Install Parameters.

2. Set up Install Parameters.

Note: These setup suppliers will be available in CMRO OSP 
Vendor Name list for the user to select.

Note: To find the approver of the contracts, you must look at the 
profile value: OKC: Contract Approver.
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Figure 2–62 Installed Parameters Window

3. Set up Instance Statuses.
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Figure 2–63 Instance Statuses Window

4. Optionally, set up Maintain Locations.

5. Set up Asset Locations. 

See Also:
Oracle Install Base Implementation Guide
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Setting Up Oracle Counters

To set up Oracle Counters:
1. From the Navigator, select Field Service Manager > Field Service Set Up > 

Counters > Define Counters.

2. Click the New button. Set up Counter Groups. 
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Figure 2–64 Setup Counters Window

3. Associate the Counter Groups with the Install Base items.

4. Optionally, associate the Counter Groups with Maintain Locations.

See Also:
Oracle Service Implementation Guide
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Setting Up Oracle Quality
Oracle CMRO uses the setup from Route Management and the system profile 
options in Oracle Quality, to allow maintenance organizations to capture quality 
elements for operations, jobs, deferrals, scrap management, and capturing counter 
value snapshots. This gives maintenance facility the flexible integration required to 
maintain reliable products.

Oracle CMRO provides seeded plan templates for routes, operations, job deferrals, 
MRB dispositions and counter reading capturing. These templates can either be 
used as-is or adjusted with additional quality elements, except the counter reading 
template which is used by CMRO in the background and cannot be changed.

Setting up Oracle Quality includes:

■ Setting-up Route and Operation Quality Plans

■ Setting-up Job Deferral, MRB Disposition Quality, Non-Routine Job Inspection 
and Non-Routine Operation Inspection Plans

■ Setting up Counter Readings Quality Plan

Setting Up Route and Operation Quality Plans

Creating Inspection Types
You can create the different Inspection Types for route and/or operation quality 
recording. The inspection types are maintained in a seeded collection element called 
Inspection Type. Creating collection elements, collection element types and 
collection plan types have no specific CMRO set up requirements.

To create Inspection Types:
1. Change responsibility to Manufacturing and Distribution Manager. From the 

Navigator, select Quality > Setup > Collection Elements. From the organization 
list, select the Organization that you want to set-up the quality plan for. The 
Collection Elements window appears.

2. Query for or find the Collection Element ‘Inspection Type’.

3. Click the Values button.

4. Define Inspection Types.
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Figure 2–65 Collection Elements Window

Note: The defined inspection types are the values that appear in 
the list of values for the quality inspection type attribute in routes 
and operations.
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Creating Quality Plans
CMRO provides plan templates with seeded quality elements. Oracle recommends 
that you use these templates and adjust them for the specific needs rather than 
creating a plan from scratch, because the template contains collection elements that 
are automatically populated by CMRO when quality is recorded in production. 
Should these elements be missing, the procedure would still work, but these 
attributes would not be recorded. The background attributes contain information 
about the job, maintenance requirement, item and item instance etc., which allow 
for a convenient quality reporting and analysis. The templates also contain seeded 
displayed items that are either mandatory or optional. Those properties can be 
changed. This approach enables the user to take full advantage of CMRO’s 
out-of-the-box quality functionality together with the flexibility to create completely 
customized quality plans. Creating and using plan types has no specific CMRO set 
up requirements.

To create Quality Plans:
1. Navigate to Quality > Setup > Collection Plans. The Collection Plans window 

opens.

2. Define the collection plan. Select the plan type.

3. Click the Copy Elements button. The Copy From Plan window appears.

4. Select the Plan template that you want to copy from. For CMRO, the options 
are:

■ Advanced Service Online Route Completion Plan 

■ Advanced Service Online Operation Completion Plan
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Figure 2–66 Collection Plans Window

5. Click the Transactions button. The Collection Transaction window appears.

6. Select the seeded transaction for either route or operation. The options for 
CMRO are:

■ Maintenance Route Completion (Advanced Service Online)

■ Maintenance Operation Completion (Advanced Service Online)
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7. Define the trigger. Select Inspection Type from the Trigger name list of values. 
The trigger value is selected from the set-up in the Inspection Type collection 
element.

8. Save your work.

Figure 2–67 Collection Transactions Window
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Setting Up Job Deferral, MRB Disposition Quality, Non-Routine Job Inspection and 
Non-Routine Operation Inspection Plans

Creating Inspection Types
An Inspection Type for Deferral, MRB, Non-routine job and Non-routine operation 
is defined in a system profile option. The Inspection Type will derive the existing 
plan in the organization where a job is deferred in, an mrb disposition is initiated 
and/or a non-routine job/operation is created. You can create the different 
inspection types for job deferral, mrb disposition, and non-routine quality 
recording.

To create Inspection Types:
1. Navigate to the Collection Elements window. Query for the Collection Element 

‘Inspection Type’.

2. Click the Values button. Define Inspection Types for Job Deferral, MRB 
Disposition, and Non-Routine quality recording. 

Creating Quality Plans

To create Quality Plans:
1. Navigate to the Collection Plans window.

2. Define collection plans for Job deferral, MRB disposition and Non-Routine 
job/operation using the following plan templates:

■ Advanced Service Online Job Deferral Plan

■ Advanced Service Online MRB Disposition Plan

Note: The Inspection Types created can be associated with a route 
or operation in route management. When the route and/or 
operation is going to be instantiated in production the user will 
have the derived quality plan available for collecting the quality 
results.

Note: The defined inspection types appear in the list of values for 
the system profile option for job deferral and mrb disposition.
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■ Advanced Service Online Route Completion Plan 

■ Advanced Service Online Operation Completion Plan

3. Add or change quality elements if necessary. 

4. Click the Transactions button. Select the following seeded transaction 
descriptions for job deferral, mrb disposition and non-routine job/operation:

■ Maintenance Job Deferral (Advanced Service Online)

■ MRB Disposition (Advanced Service Online)

■ Maintenance Route Completion (Advanced Service Online)

■ Maintenance Operation Completion (Advanced Service Online)

5. Define the trigger. Select Inspection Type from the Trigger name list of values. 
The trigger value is selected from the set-up in the Inspection Type collection 
element.

6. Save your work.

System Profile Options Setup
Set up the following System Profile Options for Job Deferral, MRB disposition and 
Non-Routine job/operation quality definition:

■ AHL: Job Deferral Inspection Type

■ AHL: MRB Disposition Inspection Type

■ AHL: Non-routine Job Inspection Type

■ AHL: Non-routine Operation Inspection Type

Setting Up Counter Readings Quality Plans
Whenever a maintenance requirement is completed in production, CMRO stores the 
current counter values of the maintained item instance in a Counter Reading 
Quality Plan. The plan will adjust itself based on the counters defined on the item 
instance. This procedure is completely transparent to the end user. The user must 
create a Counter Reading Quality Plan in quality and set up the system profile 
option to enable counter reading capturing.
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Creating Quality Plans
The Counter Readings Quality Plan is created using the template and cannot be 
adjusted, since the end-user has no influence over the recording of the counter 
values.

To create Quality Plans:
1. Navigate to the Collection Plans window. Define the collection plan.

2. Select the plan type from the Plan Type list of values.

3. Click the Copy Elements button. Select the following plan template: Advanced 
Service Online Counter Readings Plan

4. Do not define any Transactions. 

System Profile Options Setup 
For the Counter Reading Quality definition, set up System Profile Option -AHL: 
Counter Reading Plan.

See Also:
Oracle Quality User’s Guide

Setting Up Oracle Content Manager
Oracle Content Manager integrates with Oracle CMRO to provide the user with the 
capability to upload electronic files. The electronic file upload feature is used within 
the Document Index module in Oracle CMRO. 

To upload electronic files, you must ensure that the following tables are set up in 
Oracle Content Manager:

Note: You need to create only one Counter Reading plan because 
the same is used across all organizations. 

Note: Do not adjust collection elements.
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If the records are not present in ibc_content_types_b and ibc_attribute_types_b, then 
run the ahlctype.ldt file. This will ensure that the records are inserted into the 
appropriate tables.
 

CMRO Specific Setups
Oracle Complex Maintenance, Repair, and Overhaul is an integrated, web-enabled 
software application suite designed to empower complex equipment maintenance 
organizations. Oracle Complex Maintenance, Repair, and Overhaul supports 
maintenance processes such as scheduled and unscheduled maintenance visits, 
component monitoring, job scheduling and routing, labor time collection, cost 
collection, inventory management, and maintenance document management. It 
provides models for electromechanical systems and defines rules for assembling 
units. It also records unit-specific information, allowing quick access to the 
maintenance history of a product component. 

Oracle Complex Maintenance, Repair, and Overhaul is organized as follows:

1. Engineering

Table 2–19 ibc_content_types_b

Attribute Data

CONTENT_TYPE_CODE AHL_DOCUMENT

CONTENT_TYPE-STATUS ACTIVE

Table 2–20 ibc_attribute_types_b

Attribute Data

ATTRIBUTE_TYPE_CODE DOCUMENT

CONTENT_TYPE_CODE AHL_DOCUMENT

DATA_TYPE_CODE ATTACHMENT

MIN_INSTANCES 1

UPDATEABLE_FLAG T

Note: To upload files, AHL_MEDIA_TYPE lookup must have the 
value E-File. For more information, refer to the Document Index 
module setup on page 2-132     
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■ Fleet Maintenance Program (maintenance requirements)

■ Route Management (work card authoring)

■ Document Index (technical document management)

2. Configuration Management

■ Master Configuration (allowable installations)

■ Unit Configuration (as installed maintenance tracking)

■ Product Classification (logical grouping)

3. Planning

■ Unit Maintenance Plan (active maintenance requirements)

■ Visit Work Package (work scope and resource)

■ Long Term Plan (hangar and visit plan)

4. Execution

■ Production

■ Production Planning

■ Outside Processing

This section includes the following:

■ Oracle Complex Maintenance, Repair, and Overhaul Standard Setup on 
page 2-113

■ Oracle CMRO Approval Workflow Setup on page 2-114

■ Oracle CMRO Module Setup on page 2-131

Oracle Complex Maintenance, Repair, and Overhaul Standard Setup
CMRO General Setup includes setting up the System Profile options as indicated in 
the table below.
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Oracle CMRO Approval Workflow Setup
You can set up an Approval Workflow to approve maintenance programs, activities 
and routes. You can use the built-in Approval Workflow or you can create your own 
workflow, define a specific approval rule and create a list of approvers for each 
CMRO object. After setting up profile options, if you do not specify an approval 
rule, the application uses the default approval rule.

CMRO Approval Workflow setup includes:

■ Setting up Profile Options

■ Creating Approval User(s) and Role(s)

Setting Up Profile Options
By default, Maintenance Programs, Activities and Routes are automatically 
approved at the time of creation when you click the Approved button. To set up an 
Approval process, you must set up the system profile options as indicated in the 
table below.

Table 2–21 System Profiles

Profile Site(Value) Descriptions

AHL: Preventive 
Maintenance Installation

Yes/No Indicates whether the 
installation for 
preventive maintenance 
is set toYES.

AHL: Turn On 
Development Debug

Yes/No Enable/disable debug 
session

AHL: Turn on File Debug Yes/No

Table 2–22 Profile Options

Profile Value Description

AHL: Enable approval 
workflow for Routes 

Yes This enables the approval 
workflow for the routes

AHL: Enable approval 
workflow for 
Maintenance 
Requirement

Yes This enables the approval 
workflow for 
maintenance programs 
and activities
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Creating Approval User(s) and Role(s)
To activate the enabled workflow, you must set up employees in Oracle Human 
Resources, create application users and define approval roles for these employees, 
and create approval rules for the different CMRO objects. 

Defining Approval Employees in Oracle Human Resources
All approval users need to be defined as employees in Oracle Human Resources.

For more information on how to set up employees, refer to the Oracle Human 
Resources Implementation guide.

AHL: Workflow Loop 
Counter

Requires a numeric value 
that defines how many 
times the notification will 
be re-sent if the user does 
not respond

-

AHL: Workflow Timeout 
Minutes

Requires a numeric value 
that defines the period 
after which a workflow 
times out when its 
progress is halted. 

-

Note: The following set up steps are depending on the use of the 
seeded approval workflow. If you decide to create your own 
workflow you will have to adjust these steps to the functionality of 
this workflow.

Note: If you want to notify the approval user via e-mail, then in 
addition to the application work list notification, you must also set 
up the e-mail address for the employee in the Office Details 
window.

Table 2–22 Profile Options

Profile Value Description
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Creating Application User for Approval Employees
Every approval employee needs to have an Oracle Application login. When 
defining the application user you have to associate the approval employee, set up 
earlier in HR, to that application user. 

Creating Approval Roles
Associating the approval employees to a role is an optional step. If you have set up 
the employees in Oracle HR and created application users for them, you can 
associate the employee directly with an approval rule. You can set up the following 
two types of approval roles: 

Default Approval Role  

CMRO provides a seeded default approval rule that is used when no object specific 
approval rule is set up. The default approval rule is best used, when the same 
people in the same hierarchy will approve every CMRO object. In this case you only 
have to set up one rule with one approval sequence. The default approval rule has 
also one approval hierarchy with a seeded role defined.

To set up the Role for the Default Approval Rule:
1. Login to the forms environment of Oracle Applications. Select the CRM 

Resource Manager responsibility.

2. Navigate to Setup > Role Types.

3. Query for JTF_RS_ROLE_TYPE.

4. Create a role type code for the default approval role.
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Figure 2–68 Application Object Library Window - Role Type Lookups

5. Navigate to Setup > Roles.

6. Create a role with the code AHL_DEFAULT_APPROVER.
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7. Associate the default approval role type code to this role.

Note: The code must be defined as described above otherwise the 
default rule will not recognize this role. The role name can be user 
defined.
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Figure 2–69 Roles Window

8. Create additional roles if you need more than one level of approvals. The role 
codes can be user defined for every additional role used for the default 
approval rule.
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General Approval Role  

Perform the following set up steps if you have specific approval rules for the 
different CMRO objects: 

1. Login to the forms environment of Oracle Applications. From the Navigator, 
select CRM Resource Manager.

2. Navigate to Setup > Role Types.

3. Query for JTF_RS_ROLE_TYPE.

4. Create role type code(s) for the General Approval Role(s). 

Note: For CMRO approval, only one user can be associated with a 
role, otherwise the approval workflow will fail. Therefore, you 
must create as many roles as you have approvers. The sequence of 
notification will be defined in the approval rule setup.
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Figure 2–70 Application object Library Window

5. Navigate to Setup > Roles. Create a role for every possible approver. 

Note: You can create multiple role type codes for grouping the 
roles together but one is minimum.
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6. Associate the appropriate approval role type code to the roles.

Figure 2–71 Roles Window

Importing Resources
After you have created the employees and the roles, you must map the two 
together.
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To import resources:
1. From the CRM Resource Manager responsibility, navigate to Maintain 

Resources > Import Resources.

2. Select the approval employee. Click the Search button.

3. Click Create Resource. Select the appropriate role.

4. Click OK. Click Save Resource.

Note: As previously mentioned, only one employee can be 
assigned as a workflow approver. However, the same employee can 
be the designated approver for multiple roles.
Setting Up 2-123



Oracle CMRO Approval Workflow Setup
Figure 2–72 Selection Criterion Window

5. If you want to associate the same employee with an additional role click Details. 
Add Roles. 

6. Repeat steps 1 through 5 for every approval employee.
2-124 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 



Oracle CMRO Approval Workflow Setup
Creating Approval Rules in CMRO
As mentioned earlier you can either use the seeded default approval rule or specify 
an object specific approval rule for the different CMRO objects. In the approval 
details you can either pick a role that you have set up, or a user that has been 
created as an employee in HR, and is associated with an application login. The 
sequence in the approval details defines the approval hierarchy.

Default Approval rule  

To adjust the Default Approval Rule:
1. Login to the jtf environment of CMRO. 

2. Click on the Administration link. Click the Go button.

3. Click on the link 'Default AHL Rule'.

4. Add any additional roles or users to the approval details in the sequence you 
want your objects to be approved.

Note: The first role is seeded. You can either change the hierarchy 
or delete the seeded role if necessary.
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Figure 2–73 Update Approval Rule Page

5. Click Apply.

Object Specific Approval Rule  

Note: Do not add any values to the operating unit attribute or to 
the priority attribute. Custom values are currently not supported by 
Complex Maintenance, Repair, and Overhaul and would cause the 
workflow to fail. Also, you cannot change the status of the default 
rule once it is set to Obsolete.
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To define approval rules with specific approval hierarchy:

1. Login to the jtf environment of CMRO. 

2. Click on the Administration link.

3. Click the Create button.

4. Create Approval Rules for Maintenance Request and/or Route Management.

5. Select Approval Type 'Concept'.
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Figure 2–74 Create Approval Rule Page

6. Do not add any values to the operating unit attribute or the priority attribute. 
Click Apply.

7. Add roles or users to the approval details in the sequence in which you want 
your objects to be approved.

8. Select Active from the Status list of values.
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Figure 2–75 Update Approval Rule Page

9. Click Apply. 

Workflow Process Mapping
The final step in the approval workflow set up is to map the object with a workflow. 
As previously mentioned, Oracle recommends that you use seeded workflow that is 
delivered with CMRO, however a user-defined workflow can be mapped to the 
CMRO object as well. 

To map the workflow with the CMRO object:
1. Login to the jtf environment of CMRO. 

2. Click on the Administration link.
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3. Click the Workflow tab.

4. If you want to use the same workflow for all of your objects, leave the object 
field empty, otherwise choose the object, which you want to remove from the 
drop-down list.

5. Define the desired workflow in the Process Name field. The CMRO default 
workflow is called ASO Generic Approval Process.

Figure 2–76 Workflow Process Mapping Page

6. Click Apply.
2-130 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 



Oracle CMRO Module Setup
The Approval Workflow
When a Maintenance Program, Activity or Route is sent for approval the user 
defined in the approval role is notified by e-mail, if it has been setup at employee 
creation, and/or with an entrance in the work list in Oracle Applications. From the 
notification, the user can navigate to the notification details and approve the 
program, activity or route. The workflow moves sequentially through all of the 
roles defined in the approval rules details until the last user has sent his approval. 
At this point the status of the approved object will be changed from 'Approval 
Pending' to 'Approved'.

Oracle CMRO Module Setup
Oracle Complex Maintenance, Repair, and Overhaul enables maintenance 
organizations to meet customer expectations, and draw maximum benefit by 
improving the operational readiness of equipment.

Oracle CMRO Module setup includes:

■ Setting Up Document Index on page 2-131

■ Setting Up Route Management on page 2-134

■ Setting Up Product Classification on page 2-142

■ Setting Up Master Configuration on page 2-144

■ Setting Up Unit Configuration on page 2-147

■ Setting Up Fleet Maintenance Program on page 2-150

■ Setting Up Unit Maintenance Plan on page 2-152

■ Setting Up Visit Work Package on page 2-157

■ Setting Up Long Term Planning on page 2-161

■ Setting Up Production on page 2-164

Setting Up Document Index
The Document Index module in Oracle Complex Maintenance, Repair, and 
Overhaul is the central repository for managing all maintenance documents.

Maintenance personnel can:

■ Access an online catalog of documents used in maintenance, repair, and 
overhaul operations
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■ Receive, distribute, and control revisions in technical documentation

■ Search the database to quickly refer to a document

■ Create new documents or document revisions

■ Associate subtypes to document types for easy identification

■ Upload electronic documents

Maintenance document management involves tracking documents and their 
revisions, validating document references from multiple levels of maintenance 
operations, and making them easily accessible to the maintenance personnel.

Setting up Document Index includes defining the lookup values as indicated below.

To define lookups for Document Index:
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Note: Lookup codes fall within three categories: extensible, user 
defined, and system defined. If a lookup code is extensible, the 
existing lookup codes cannot be modified, but new codes can be 
added to the table. If lookup codes are user defined, all codes can 
be modified. If lookup codes are system defined, the existing codes 
cannot be modified, and new codes cannot be added to the table.

Attribute Lookup Suggested Values Access Level

Operator AHL_OPERATOR_TYPE Operator, Owner(User 
defined)

User

Document 
Type

AHL_DOC_TYPE Aircraft, Engine (User 
defined)

User

Media Type AHL_MEDIA_TYPE E-File, CD-ROM, 
On-line, Paper

Extensible

Status AHL_SUBSCRIBE_
STATUS_TYPE

Active, Not available User

Sub-Type AHL_DOC_SUB_TYPE Airworthiness 
Directives, Service 
Bulletin 

User
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Figure 2–77  Application Object Library Lookups Window 

Revision 
Type

AHL_REVISION_TYPE Temporary Revision, 
Full Revision

User

Attribute Lookup Suggested Values Access Level
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Setting Up Route Management
The Route Management module in Oracle Complex Maintenance, Repair, and 
Overhaul provides a single interface for managing all maintenance tasks. 

Maintenance personnel can:

■ Prepare and maintain work instructions.

■ Search the database for a specific operation for reference purposes, or for 
editing purposes

■ Create an operation or define instructions for carrying out a maintenance 
task

■ Search for maintenance routes, for reference, or for editing route 
information

■ Create a maintenance route

■ Associate major and sub zones in a system to a product type to facilitate 
tracking of maintenance operations on complex electromechanical systems

The intuitive user interface of Oracle Complex Maintenance, Repair, and Overhaul 
is designed to enable maintenance personnel to handle operational needs as 
effortlessly and quickly as possible.

Before setting up Route management, you must ensure that:

■ ASO Resource is set up

■ BOM Resource is set up

Setting up Route Management includes:

■ Defining Lookup values

■ Setting up Flexfields

To define lookups for Route Management:
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Attribute Lookup Suggested Values Access Level

Operation 
Type

AHL_ROUTE_TYPE Aircraft, Engine, 
Ground support

User
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Major Zone AHL_MAJOR_ZONE Cargo Compartment, 
Cockpit

User

Sub Zone AHL_SUB_ZONE AFT Fuselage, 
Cabin

User

Status AHL_REVISION_STATUS Approved Pending, 
Complete

System

Status Type AHL_SUBSCRIBE_
STATUS_TYPE

Active, Available User

Sub-Type AHL_DOC_SUB_TYPE AD, SB User

Revision 
Type

AHL_REVISION_TYPE Temporary, Full 
Version

User

Process AHL_PROCESS_CODE Access, Cleaning, 
Close

User

Attribute Lookup Suggested Values Access Level
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Figure 2–78 Defining Lookup: AHL_PROCESS_CODE
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To set up Flexfields:

Validate Existence of Route Flexfield

1. Login into the forms environment with Application Developer Responsibility.

2. Navigate to Flexfield > Key > Segments.

3. Query for Flexfield Title ‘AHL Route’. Query should return the record.

Note: To enable Route Management, you must set up a key 
flexfield to define the System attribute.
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Figure 2–79 Key Flexfield Segments Window

 

Add segments to this flexfield
1. Click the Segments button.

2. Enter Records for System Flexfield Segment.
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Figure 2–80 Segments Summary Window

Create Value Sets to be used by Flexfield Segments
1. Click the Value Set button.

2. Define Value Set Name.

3. Define List Type as ‘List of Values’.
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4. Define Security Type as ‘No Security’.

5. Define Format Type as ‘Char’.

6. Define Validation Type as ‘Independent’.

Figure 2–81 Value Sets Window

 

7. Update Flexfield Segments with the Value Sets.
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Create values for Value Sets
1. Navigate to Flexfield > Key > Values.

2. Find the Value Sets for the System Flexfield.

Figure 2–82 Segment Values Window

3. Add the desired values to the Value Set.
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Setting Up Product Classification
The Product Classification module in Oracle Complex Maintenance, Repair, and 
Overhaul enables maintenance engineers to create and maintain product 
classifications. Product Classification provides a hierarchy within which parts and 
units can be grouped. 

Maintenance Personnel can:

■ Search the database to quickly refer to a product classification

■ Create new product classifications or product classifications revisions

■ Edit and copy product classifications

■ Associate documents to a nodes product classifications

■ Attach parts or units to product classifications

■ View maintenance requirements associated to a product classification node

■ View Utilization forecast of a product classification

■ Check for completeness of primary product classifications

■ Launch the approval process for a draft product classification

Product Classification allows organizations to provide a multilevel hierarchy that 
logically groups products together. Product classifications are used mainly to define 
maintenance requirements and documents applicability as well as provide a basis 
for analysis and reporting.

Setting up Product Classification includes defining the lookup values as indicated 
below.

To define lookups for Product Classification:
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Attribute Lookup Suggested Values Access Level

Status AHL_PC_STATUS Approval Pending, 
Approval Rejected, 
Complete, Draft

User

Status AHL_PC_EDIT_STATUS Complete, Draft User
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Association 
Type

AHL_PC_ASSOS_TYPE Unit, Part User

Action AHL_PC_ACTION_TREE_
LIST

Add Node, Delete 
Node

User

Action AHL_PC_FMP_TREE_
ACTION_LIST

Attach User

Attribute Lookup Suggested Values Access Level
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Figure 2–83 Defining Lookup: AHL_PC_ACTION_TREE_LIST

Setting Up Master Configuration
The Master Configuration module in Oracle CMRO provides models of 
electromechanical system assemblies. A master configuration model will form the 
basis of a unit in combination with business rules that specify the systems and 
subsystems that may be included in the assembled unit.
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Maintenance personnel can:

■ Search the database for master configurations of electromechanical system 
assemblies

■ Create system assembly master configurations

■ Search for alternate parts that may be used in place of specified components 
in an assembly

Before setting up Master Configuration, you must ensure that:

■ Inventory (Item Master) set up is complete

■ Approval Workflow is set up (This step is optional if the user selects the default 
approval workflow) 

Setting up Master Configuration includes defining the lookup values as indicated 
below.

To define lookups for Master Configuration
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Attribute Lookup Suggested Values Access Level

Status AHL_CONFIG_STATUS All, Closed, Complete, 
Expired, Incomplete, 
Draft

System

Action AHL_MC_ACTION_TREE_
LIST

Add, Copy, Delete System

Necessity AHL_POSITION_
NECESSITY

Mandatory, Optional User

Rule code 
(Position 
ratio list)

AHL_COUNTER_RULE_
TYPE

Bird Strike, Heavy 
Landing

User

Interchange 
(Edit 
Alternate)

AHL_INTERCHANGE 1-Way, 2-Way, No 
Interchange, 
Superseded By

Extensible
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Figure 2–84 Defining Lookup:AHL_CONfIG_STATUS

Type (Edit 
Alternate)

AHL_ITEM_TYPE Delete, Obsolete, 
Prime, 
Interchangeable, 
Reference, 
Superseded Item

Extensible

Attribute Lookup Suggested Values Access Level
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Setting Up Unit Configuration
The Unit Configuration module in Oracle Complex Maintenance, Repair, and 
Overhaul enables organizations to describe the structure of an assembled 
electromechanical system. The as-constructed configuration of an assembly will 
determine the specific maintenance program required to ensure the operational 
readiness of that unit.

Maintenance personnel can:

■ Initiate proper maintenance activities to resolve issues

■ Create unit configurations from existing master configurations

■ Search for unit configuration records that exist in the database

■ Add new part information to the database

■ Search for, and update existing part information

The Unit Configuration module in Oracle CMRO is a key feature that enables 
maintenance organizations to determine services required. Even if two units have 
the same part number, or belong to the same product family, their configurations 
are normally different due to the operation and maintenance history of each unit. 
Unit Configuration provides models of individual tracked parts to support 
unit-specific information.

Before setting up Unit Configuration, you must ensure that Master configuration is 
set up and products are available for association at the unit level.

Setting up Unit Configuration includes defining lookup values and setting up 
attributes as indicated below.

To define lookups for Unit Configuration
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Attribute Lookup Suggested Values Access Level

Status AHL_CONFIG_STATUS All, Close, Complete User

Tag AHL_SERIALNUMBER_
TAG

Actual, From 
Inventory, Temporary

User
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Figure 2–85 Defining Lookup: AHL_ITEM_TYPE

To set up attributes
1. Change responsibility to Oracle Install Base Admin.

2. From the Navigator, select Setups > Extended Attribute Template. The 
Extended Attributes window appears.

3. Set up the attributes as indicated in the table below.
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4. Save your work.

Table 2–23 Extended Attributes Window

Attribute Code Attribute Name

AHL_MFG_DATE Manufacturing Date

AHL_TEMP_SERIAL Serial Number Tag 
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Setting Up Fleet Maintenance Program
The Fleet Maintenance Program module in Oracle CMRO enables maintenance 
organizations to record, organize, and plan maintenance requirements. Maintenance 
planners can create maintenance requirement records and attach attributes to these 
records. The attributes attached to the record enables maintenance planning and 
increased operational efficiency while accomplishing a requirement. 

Maintenance planners can:

■ Search the database for a specific maintenance requirement for reference, or 
for editing purposes

■ Create a maintenance requirement record in the database

■ Attach documents, maintenance routes, actions, effectivities, and 
maintenance requirement relationships to the record

■ Create revisions for maintenance requirements that are complete

■ View items that are affected by a maintenance requirement

The Oracle CMRO Fleet Maintenance Program module serves as a repository for 
scheduled maintenance and associated information.

Before setting up Fleet Maintenance Program, you must ensure that:

■ Lookup values are set up

■ System profile options are set up in Oracle Application: Profile system value

■ Route Management is set up

■ Product Classification is set up

■ Master Configuration is set up

■ Unit Configuration is set up

■ Set up ASO Visit Work Package

Setting up Fleet Maintenance Program includes defining the lookup values as 
indicated below.

To define lookups for Fleet Maintenance Program: 
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.
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Attribute Lookup Suggested Values Access Level

Program 
Type

AHL_FMP_MR_
PROGRAM_TYPE 

Corrosion Prevention, 
Progressive 
Maintenance, 
Company Test, Phase 
Check, etc.

Extensible

Category AHL_FMP_MR_
CATEGORY 

Power plant, airframe, 
component, ground 
equip., etc.

Extensible

Status AHL_FMP_REVISION_
STATUS

approval pending, 
approval rejected, 
complete, draft, 
terminated

System

Program 
Subtype

AHL_FMP_MR_
PROGRAM_SUBTYPE

A, B, C Extensible

Implement 
Status

AHL_FMP_MR_
IMPLEMENT_STATUS 

mandatory, optional- 
implement, optional- 
do not implement

System

Whichever 
Comes

AHL_FMP_THRESHOLD_
FIRST

First, Last System

Service Type AHL_FMP_MR_SERVICE_
TYPE

On, Off System

Show AHL_FMP_MR_SHOW_
REPETITIVE

All, Next System

Relationship 
Type

AHL_FMP_MR_
RELATIONSHIP 

Child, Parent System

Status 
(Overview 
UI)

AHL_FMP_MR_SEARCH_
STATUS

active, all, approval 
pending, approval 
rejected, complete, 
draft, terminated

System

Dependency 
(will it be 
enable for 
this release)

AHL_FMP_MR_ROUTE_
SEQUENCE

Execute before, 
Execute after

System
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Figure 2–86 Defining Lookup:AHL_FMP_REVISION_STATUS

Setting Up Unit Maintenance Plan
The Unit Maintenance Plan module in Oracle Complex Maintenance, Repair, and 
Overhaul ensures that all maintenance requirements are met on or prior to their due 
date. It also provides demand estimates over a planning time window by 
forecasting the due date of maintenance requirements associated with a unit. It 
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searches and displays maintenance requirements that are due for an equipment unit 
and provides maintenance personnel instant access to maintenance requirements, 
due date estimation, accomplishment history, and planning information for a unit 
configuration.

Maintenance personnel can:

■ Maintain utilization forecasts

■ View the serviceable time remaining of a unit

■ Model repetitive maintenance requirements over a specified time period

■ Calculate the due dates of maintenance requirements

■ Associate maintenance requirements to a visit

Unit Maintenance Plan serves as a repository of the maintenance requirements 
related to units and any related subassemblies or components. It also enables 
forecasting of usage to determine due dates for fleet maintenance activities.

Before setting up Unit Maintenance Plan, you must ensure that:

■ Look up value is set up in Oracle Application 

■ System profile is set up in Oracle Application: Profile system value

■ Product Classification is set up

■ Master Configuration is set up

■ Unit Configuration is set up

■ Set up CMRO Visit Work Package

Setting up Unit Maintenance Plan includes:

■ Setting up System Profiles

■ Defining Look up values

To set up the System Profile Options:
1. Login using the System Administrator responsibility. Navigate to the System 

Profile Values window.

2. Set up the following System Profiles:

■ AHL: Maximum Planning Window (Number)

■ AHL: Maximum Planning Window (UOM)
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Figure 2–87 System Profile Values Window

These profile options determine the period that is taken into account when 
calculating the due date and repetitive MR in Unit Maintenance Plan. For example, 
the user may set the following values for the profile options:

AHL: Maximum Planning Window (Number) = 2 

AHL: Maximum Planning Window (UOM) = Years 
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This means that the rolling planning windows in Unit Maintenance Plan (UMP) is 
two years.   The concurrent program used to calculate the due date and repetitive 
MR will calculate all due dates within two years starting from calculation date 
(current date). 

To define lookups for Unit Maintenance Plan
1. Change responsibility to Application Developer.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Attribute Lookup Suggested Values Access Level

Use in 
System 
Profile list 
box 'Site's

AHL_UMP_TIME_UOM Days, Weeks, Months, 
Years

User 

Select Unit 
Maintenance 
Plan and…

AHL_UMP_SMR_
ACTIONS

Associate to Visit, 
Calculate Due date, 
Initialized 
Maintenance 
Requirement, View 
Detail and History, 
View Group 
Maintenance 
Requirement, View 
Threshold

User 

Status AHL_UNIT_EFFECTIVITY_
STATUS

All, Accomplished, 
Deferred, Exception, 
Initial 
Accomplishment, 
First Due, Terminate 
by new revision, 
Opened, Scheduled, 
Terminate 

User

Message AHL_UNIT_EFFECTIVITY_
MESSAGE

Deferred, Init_due, 
Init_accomplished

User
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Figure 2–88 Defining Lookup:AHL_UMP_TIME_UOM

Concurrent Program Setup
Program: Building Unit Effectivities

Short Name: AHLUEFF

Application: Oracle Complex MRO
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Description: Building Unit Effectivities

Setting Up Visit Work Package
The Visit Work Package module provides planning capabilities including creation, 
organization, and scheduling of maintenance visits based on maintenance 
requirements. It allows creation and management of visit templates based on 
equipment types enabling efficient visit package creation for equipment units of a 
type. The Visit Work Package permits association of tasks with visits and visit 
templates, and definition of task hierarchy and cost structure.

Maintenance planners can:

■ Create maintenance visit records, new, or from a template

■ Search for, retrieve, and update existing visit records

■ Associate tasks with visits: planned tasks, tasks that are required but not 
scheduled, and ad hoc tasks that are not associated with maintenance 
routes

■ Search for, retrieve, and update tasks associated with a visit

■ Create visit templates, new, or from an existing visit record

■ Search for, retrieve, and update existing visit templates

■ Search for, retrieve, and update visit template tasks

■ Create shift schedules for department workers based on planned visits

■ Search for and retrieve existing department shifts

Visit Work Package enables maintenance planners to organize a maintenance visit 
execution for an equipment unit.

Before setting up Visit Work Package (VWP), you must:

■ Verify Projects (VWP exports visit objects to Oracle Projects)

■ Verify HRMS (VWP uses HR's organization information)

■ Verify Installed base (VWP uses IB's item instance information about 
maintainable assets)

■ Verify Inventory (VWP uses Inventory's information to describe maintainable 
asset types)

■ Verify Support (VWP associates Service Requests with maintenance visit tasks) 
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■ Verify Unit Maintenance Plan (associates UMP MR to VWP)

■ Verify Fleet Maintenance Program

■ Create Project Template

Setting up Visit Work Package includes:

■ Setting up System Profile Options

■ Defining lookups

To set up System Profile Options:
1. Login using the System Administrator responsibility. Navigate to the System 

Profile Values window.

2. Set up System Profile Option: 

AHL: Default Project Template ID (Name of the Project template that will be used as 
default)
2-158 Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide 



Oracle CMRO Module Setup
Figure 2–89 System Profile Value - AHL: Default Project Template 

To define lookups for Visit Work Package:
1. Change responsibility to Application Developer.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.
Setting Up 2-159



Oracle CMRO Module Setup
Attribute Lookup Suggested Values Access Level

Status AHL_VWP_VISIT_STATUS Closed, Released 
Incomplete, Planning, 
Released

User

Visit Type AHL_PLANNING_VISIT_
TYPE

A-Check, B-Check, 
C-Check

User

Category AHL_LTP_SPACE_
CATEGORY

Category 1, Category 
2…

User

Assign 
Status

AHL_VWP_ASSIGN_
STATUS

Fully Assigned, 
Partial Assigned

User

Hour List AHL_VWP_HOURS 00, 01… User

Task 
Hierarchy

AHL_VWP_TASK_
HIERARCHY

Before, After User

Task Type AHL_VWP_TASK_TYPE Planned, Un-Planned, 
Summary, 
Un-associate

User

Visit Number AHL_VWP_VISIT_
NUMBER

Multiple User
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Figure 2–90 Defining Lookup: AHL_VWP_VISIT_STATUS

Setting Up Long Term Planning
The Long Term Planning module is used by a maintenance planner to plan 
maintenance requirements for visits based on the optimal use of maintenance 
resources. Maintenance planners using Long Term Plan make a complete 
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assessment of the resources available at all maintenance locations. The planner can 
schedule maintenance visits, assess capacity and reserve required materials.

Maintenance personnel can:

■ Assess Maintenance Workload Capacity by analysis of available labor by 
skill, level and certification, available tools, materials, and location 
capabilities balanced against known workloads

■ Create a Visit in order to group events together for long and short term 
capacity planning, and to facilitate scheduling to a maintenance base

■ Define a Visit's Resource Requirements to allow accurate scheduling and 
capacity planning

■ Analyze capacity versus work load requirements

■ Run simulations in order to evaluate different scheduling scenarios before 
implementing actual plan changes

Long Term Plan maximizes maintenance scheduling by balancing maintenance 
requirements with available maintenance capacity. The maintenance planner is able 
to do this by balancing forecasted maintenance requirement information from Unit 
Maintenance Plan against projected maintenance capacity.

Setting up Long Term Planning includes defining the lookup values as indicated 
below.

To define lookups for Long Term Planning 
1. Login using the Application Developer Responsibility.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.

Attribute Lookup Suggested Values Access Level

Category AHL_LTP_SPACE_
CATEGORY

Category 1, Category 
2…

User

Display Only AHL_LTP_VISITS_
DISPLAY_ONLY

Scheduled, 
Unscheduled

User

Status AHL_LTP_SPACE_STATUS Inactive, Active User

Period UOM AHL_LTP_DISPLAY_
PERIOD

Days, Months, Weeks User
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Figure 2–91 Defining Lookup: AHL_LTO_SPACE_CATEGORY

Visit Type AHL_PLANNING_VISIT_
TYPE

A-Check, B-Check, 
C-Check

User

Attribute Lookup Suggested Values Access Level
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Setting Up Production
The Production module enables the execution of routine and non-routine tasks and 
associated with a Visit. It also supports the execution of tasks against an Install Base 
Tracked Item.

Maintenance personnel can:

■ Search for Routine and Non-Routine Jobs using filtered search elements

■ Create Jobs from visit tasks for Scheduled, Unscheduled, and Convenience 
maintenance

■ Create Service Requests to track reported problems when an item has a 
service difficulty

■ Create Operations to Non-Routine Jobs for work definition and tracking

■ Maintain jobs by adjusting the schedule, the status, completing, deferring, 
and selecting the actual start and end for a job

■ Maintain operations by updating the operations, adding, removing, or 
updating the material and resource requirements

■ Maintain Quality using Route setup from Route Management for Job and 
Operation compliance

Maintenance schedulers can create jobs, initiate service for material and parts 
change transactions, and perform job operation maintenance.

Setting up Production includes:

■ Setting up System Profile Options

■ Defining Lookups

To set up System Profile Options:
1. Login using the System Administrator responsibility. Navigate to the System 

Profile Values window.

2. Set up System Profile Options as described in the table below.

Profile Site(Value) Description

AHL: Job Deferral Inspection Type Deferral Approval The Quality plan inspection 
type used for Production Job 
deferrals
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AHL: MRB Disposition Inspection MRB Approval 
Required

The Quality plan inspection 
type used when a tracked item 
is returned an MRB 
subinventory

AHL: Material Status - MRB Active/Non-Active The status that triggers the 
Quality inspection requirement 
for MRBand a service request 
creation, when an tracked item 
is being returned inthe 
condition associated with this 
status to a subinventory with 
the status associated

AHL: Material Status - Serviceable Active The status indicating a 
serviceable item. This status is 
used toensure that installed 
items meet the condition 
associated with this status and 
are issued from a subinventory 
with this status associated

AHL: Material Status - 
Unserviceable

Active The status that triggers the 
Service Request creation, when 
a tracked item is being 
returned in the condition 
associated with this status to a 
subinventory with the status 
associated

AHL: Non-routine Operation 
Inspection

- Used to determine if 
non-routine operation required 
inspection

AHL: OE Mixed Order Type ID P -Mixed Order type to create a OSP 
order

AHL: OE Return Line ID P- Return Line type to create a OSP order

AHL: OE Ship Only Line Type ID P- Standard Line type to create a OSP 
standard only ship line

AHL: Validate Alternate Items Yes/No Enabled/disable organization 
validation on alternate items 
for UC

Profile Site(Value) Description
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Figure 2–92 System Profile Values 

To define lookups for Production:
1. Change responsibility to Application Developer.

2. Navigate to the lookups window and define the lookups as indicated in the 
following table.
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Attribute Lookup Suggested Values Access Level

Job Status AHL_JOB_STATUS Unreleased, Released, 
Pending Routing 
Load, Failed Bill load, 
Deferred, Pending Bill 
Load, Draft, 
Cancelled, Pending 
Scheduling, On Hold, 
Failed close, Pending 
Close, Complete 
No-Charge, Pending 
Mass Load, Complete, 
Closed, Failed 
Routing load, 

User

Display Only AHL_LTP_VISITS_
DISPLAY_ONLY

Scheduled, 
Unscheduled

User

Status AHL_LTP_SPACE_STATUS Inactive, Active User

Period UOM AHL_LTP_DISPLAY_
PERIOD

Days, Months, Weeks User

Visit Type AHL_PLANNING_VISIT_
TYPE

A-Check, B-Check, 
C-Check

User
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Figure 2–93 Defining Lookup:AHL_JOB_STATUS
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Windows and Navigation Paths
This appendix provides the default navigator paths for the windows used in the Oracle 
Complex Maintenance, Repair, and Overhaul(CMRO). The following table provides the 
default navigation paths. Brackets [ ] indicate a button.

Default Navigation Paths for Standard Application  Windows

Table A–1 CMRO- Related Windows and Navigation Paths

Window Name Navigation Path

Accounting Information Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Inventory Organization > Others > Accounting 
Information

Additional Organization 
Information 

Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Organizations > HR Organization > Others

Application Object Library 
Lookups

Application Developer: Application > Lookups > Application Object 
Library 

Application Object Library: 
JTF_RS_ROLE_TYPE 
Lookups

CRM Resource Manager: Setup > Role Types

Approval Groups Manufacturing and Distribution Manager: Purchasing > Setup > 
Approvals > Approval Groups

Buyers Manufacturing and Distribution Manager: Purchasing > Setup > 
Personnel > Buyers

Category Sets Enterprise Asset Management:  Set up > Category > Category Sets
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Collection Elements Manufacturing and Distribution Manager: Quality > Setup > 
Collection Elements

Collection Plans Manufacturing and Distribution Manager: Quality > Setup > 
Collection Plans

Department Classes Manufacturing and Distribution Manager: Bill of Materials > Setup > 
Department Classes

Department Subinventories Warehouse Manager Mgmt Super User: Setup > Warehouse 
Configuration > Resources > Associate Departments & 
Subinventories

Departments Manufacturing and Distribution Manager: Bill of Materials > 
Routings > Department

Enterprise Asset Managment 
Parameters

Enterprise Asset Management: Setup > Parameters

Exp Org Defaults Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Project Expenditure/Event Organization > Others 

Find Buyer Contract Manager: Setup > Others > Buyer > Buyer

Find Categories Enterprise Asset Management: Set up > Category > Category Codes

Find Organization window Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Organizations

Find System Profile Values System Administrator > Profile > System

Find/Enter Customers Manufacturing and Distribution Manager: Order Management: 
Customers > Standard

Installed Parameters Oracle Installed BaseAdmin > Setup > Install Parameters

Instance Statuses Oracle Installed BaseAdmin > Setup > Instance Statuses

Inventory Accounting 
Periods 

Manufacturing and Distribution Manager: Inventory > Accounting 
Close Cycle > Inventory Accounting Periods

Key Flexfields Segments Application Developer: Flexfield > Key > Segments

Master Demad Schedules Manufacturing and Distribution Manager: Material Planning > MDS 
> Names

Master Item Manufacturing and Distribution Manager: Inventory > Items > 
Master Items

Material Status Definition Warehouse Manager Mgmt Super User: Setup > Transaction Setup > 
Inventory Transactions > Material Status

Table A–1 CMRO- Related Windows and Navigation Paths

Window Name Navigation Path
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MRP Names Manufacturing and Distribution Manager: Material Planning > MRP 
> Names

Open and Close Periods Manufacturing and Distribution Manager: Purchasing > Financial > 
Accounting > Open and close periods

Oracle Manufacturing 
Lookups

Enterprise Asset Management:  Setup > Lookup

Organization Parameters Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Inventory Organization > Others > Inventory 
Information

Parent Organization Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Organizations > HR Organization > Others > Parent 
organization   

Personal Profile Values Application Developer > Other > Profile

Planning Manager Manufacturing and Distribution Manager: Material Planning > Setup 
> Planning Manager

Planning Parameters Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > MRP Organization > Others

Planning Parameters Manufacturing and Distribution Manager: Material Planning > Setup 
> Parameters

Processing Constraints Manufacturing and Distribution Manager: Order Management > Set 
Up > Rules > Security > Processing Constraints

Project Manufacturing 
Parameters

Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Project Manufacturing Organization > Others 

Project Parameters Manufacturing and Distribution Manager: Project > Project 
Definitions > Project Parameters

Project Type Class 
Information

Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > Project Task Owning Organization > Others >  
Project Type Class Information 

Resources Manufacturing and Distribution Manager: Bill of Materials > 
Routings > Resources

Roles CRM Resource Manager: Setup > Roles

Search Approval Rules Advanced Service Online User: Administration > Approvals

Segment Values Application Developer: Flexfield > Key > Values

Selection Criterion CRM Resource Manager: Maintain Resources > Import Resources

Table A–1 CMRO- Related Windows and Navigation Paths

Window Name Navigation Path
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Service Request Severities Customer Support: Setup > Service Request > Request Severities

Service Request Statuses Customer Support: Setup > Service Request > Request Status

Service Request Types Customer Support: Setup > Service Request > Request Types

Setup Counters Field Service Manager : Field Service Set Up > Counters > Define 
Counters

Subinventories Manufacturing and Distribution Manager: Inventory > Setup > 
Organization > Subinventories

Subinventories Summary Warehouse Manager Mgmt Super User: Setup > Warehouse 
Configuration > Warehouse > Subinventories

Suppliers Contract Manager:  Setup > Others > Supplier > Entry

WIP Accounting Classes Enterprise Asset Management: Setup > WIP > WIP Accounting 
Classes

WIP Accounting Classes Manufacturing and Distribution Manager: WIP > Setup > WIP 
Accounting Class

Work in Process Parameters  Manufacturing and Distribution Manager: Inventory > Setup > 
Organizations > WIP Organization > Others 

Workflow Process Mapping Advanced Service Online User: Administration > Workflow

Table A–1 CMRO- Related Windows and Navigation Paths

Window Name Navigation Path
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